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Twelve years ago, when we were starting Linux
Journal, we had to answer the same questions as we
did last year when we were starting TUX. Although
this is less than the complete set, it boiled down to:

� What is needed in the Linux community?

� What can we do to address that need?

� Is it possible for the effort to support itself?

Twelve years ago, there was no commercial mar-
ket. The closest you got to Linux vendors were small
companies selling CDs with Linux on them. What the
magazine needed to do was show people that Linux
was real. That is, Linux was something that could do
useful work. By doing that, we could build a market.

Today, the picture is quite different. Commercial use
of Linux has skyrocketed and continues to grow. Linux
serves millions of Web pages, provides file servers, fire-
walls and many other systems in homes, and small and
large businesses. Linux, in embedded systems, helps
people watch TV in a new way through TiVo, provides
more capabilities in cellular phones and has even been
on board the Space Shuttle.

These 12 years have made tens of millions of
people both believe in and rely on Linux to do things
for them. In most cases, these are things that need
to be reliable. People don’t want to have to reboot
their TiVo so that it will do its job—or their Web
server. Thus, the market acceptance is there in terms
of Linux being something that works reliably.

Enter penetration into the desktop market. This
has been an uphill battle just like Apple’s Mac OS.
Along the way, other choices such as BeOS have
dropped out of the race. Good or bad, Microsoft
continues to dominate this market. Why?

Inertia is the best answer. This inertia works in two
ways. First, if you have market share, it is easy to be
able to afford to tell people you are the right answer.
It just costs less per copy to promote yourself. Beyond
that, people tend to resist change. Thus, a Ford owner
is more likely to buy another Ford than offer other
vendors a fair shake at their potential business.

With the three questions I mentioned at the
beginning of this article, what we are trying to do is
get more people to switch to Linux desktops. Even
though more of you are currently using the competi-
tion, we have to help with that inertia. Can we? I
think so. Can we show non-Linux users that it is to
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their advantage to become Linux users?
In order to address the inertia side, we
have to both assure you that Linux will be
an advantage and help you get over the
work you need to do to make the switch.

Fine. We are up for that. In fact, the
http://www.tuxmagazine.com Web site
tends to show off the advantages of
Linux, so that is one piece of the project.
The other you see here. Our monthly
magazine is all about the how-to side of
accomplishing things with Linux.

I think we have the first two questions
answered. As for the third, we need your
help. We know what it costs to produce
TUX. And you know what you are paying
for it. We don’t need to use a Linux-based
calculator program to show there is a
deficit. Clearly, there needs to be another
entry in the equation—a revenue source.

This has been relatively easy with Linux
Journal. LJ is focused at a nice technical
group of people. That makes it easy to sell
to advertisers. You folks, on the other
hand, are very diverse. We know that from
the info you gave us when you subscribed.

Here, I ask that you take a few minutes
to respond to the following questions. It
helps us build a profile of our readership.
Thanks in advance for doing this.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.

P2P

4www.tuxmagazine.com

How many of the last three digital issues have you read or looked through?
None
1 out of 3
2 out of 3
All

Considering all of the times you’ve looked at it, about how much time in total do you
spend reading or looking through an average issue?

Less than 15 minutes
15 - 30 minutes
31 - 45 minutes
46 minutes - 1 hour
More than 1 hour

How do you typically navigate through (read) your digital issue?
Read it cover to cover
Read articles of interest and look through remaining pages
Read the Table of Contents and articles of interest
Skim or look through quickly

Which of the following actions have you taken as of result of reading articles or
advertisements in your digital issue? (check all that apply)

Clicked on an ad or hyperlink to go to a company’s Web site
Called or e-mailed a vendor to get more information
Recommended the purchase of product or service
Purchased a product or service
Incorporated a new technique/medium/product
Discussed article/ad with others
Archived the issue for future reference

http://www.tuxmagazine.com
http://www.tuxmagazine.com
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Of all the issues of TUX we’ve deliv-
ered, I’m most proud of this issue, even
if I do say so myself. As I’m sure you
know by now, TUX is the first and only
magazine for the new Linux user. It got
off to a bit of a rocky start. The TUX
content was a little too advanced for
new users and addressed some philo-
sophical issues that most new users
really don’t care much about. I was
brought on board and asked to put
TUX back on track so it would better
address the target audience—Linux
desktop users, especially those who are
not all that computer-savvy.

It wasn’t easy. We had a backlog of
articles that were not as appropriate for
TUX as I’d have liked. We still had to
publish some of them simply because it
takes time to build up a backlog of arti-
cles that are appropriate for TUX. I also
bit off more than I could chew. Some of
my ideas for TUX are still on the back
burner, waiting for the day when we can
afford to implement them.

We’re not done making TUX the best
it can be, but this issue comes closer

than ever to meeting its goals. We have
some great new-user articles this month.
Don’t miss the how-to articles, they’re
terrific. One of my favorites is the how-to
article on Audacity. Audacity is a very
powerful sound editor. Granted, many of
you may think you don’t have a use for
Audacity, but you may find it very useful
as you delve into the depths of what
Linux programs can do. For example, if
someday you use Linux to customize
home videos, you can use Audacity to
edit the sound tracks for them.

THE AUDACITY OF GEORGE MARTIN
I recently ran across a very trivial but fun
use of Audacity. I was reminiscing about
some old Beatles tunes that I liked. As I
listened to the song “In My Life”, I
recalled an interesting bit of trivia about
that song and wanted to share it with
my kids. A classically trained musician,
George Martin contributed a lot to
Beatles songs. By the way, George Martin
is one of the unsung heroes behind the
Beatles. His training and talent went a
long way toward making many Beatles

songs as cleanly arranged and mixed as
they are.

Anyway, if you remember the song
“In My Life”, there is a little Baroque-
sounding instrumental ditty in the song.
It is quite well done, very faithful to
Baroque style, and it sounds difficult to
play unless you’re used to playing
Baroque music. The instrument almost
sounds like a cross between a piano and
a harpsichord.

George Martin performed this instru-
mental bridge on a plain-old piano.
Here is how you can tell. If you have
the song on disk, load it into Audacity.
Select the instrumental section and use
Audacity to play it at half speed. You
will hear it the way it was originally
recorded—an octave lower at half
speed. You can tell it was recorded this
way because it sounds exactly like a
normal piano at half speed.

At double speed, the piece plays an
octave higher than it was recorded, but it
changes the sound of the instrument
slightly, which is why it sounds like it has
a bit of “harpsichord” in it. I don’t know

Diary of a Well-Dressed Penguin
TUX is growing and getting ever closer to meeting its original goals.

NICHOLAS PETRELEY

FROM THE EDITOR IN CHIEF
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if George Martin played it at half speed
because it was too difficult to play at the
correct speed, or if he simply wanted to
alter the way the instrument sounded. I
suspect it was the latter, because if you
listen to it at half speed, you’ll hear that
he plays piano with the utmost precision,
right down to the accurately executed
Baroque trills. Anyone who plays that well
at half speed could probably play it just as
well at a normal speed.

Regardless, the Audacity program
made it easy to let my kids in on that
trivial secret.

DON’T ESCAPE INKSCAPE
My kids also inspired the approach we
took to our tutorial on how to get started
with Inkscape. My 12-year-old daughter
loves to draw cartoon characters on the
computer. She uses GIMP, and she is quite
good at using it. She knows how to han-
dle layers, transparency, shading and
many other GIMP features that even
adults find difficult.

I heard her complaining that she had a
hard time drawing the outline of her car-
toon characters freehand and then filling
the sections with color and layers of shad-

ing effects. Even with her Wacom draw-
ing tablet, it was too easy to make mis-
takes. When she made mistakes, she had
to zoom in and edit the mistakes pixel by
pixel. Even then, she had a hard time
making the drawing look right, because
the cartoon character outlines were not
perfect lines. They were too pixelated,
and sometimes they “leaked” when she
tried to color-fill them.

I introduced her to Inkscape, which is
ideal for drawing perfect outlines and
adjusting mistakes without having to go
to the pixel level. She still isn’t used to the

concept of Inkscape, which is why I fig-
ured that an introduction to Inkscape
would make an ideal article for TUX. If
we could publish an article that helps
people understand why there are times
when Inkscape is better for a drawing job
than GIMP (or better as a starting point,
after which you can use GIMP or some
other graphics program to continue), and
show them how to get started using it,
then we’ve helped more people than just
my daughter. Her case can’t be unique. If
my daughter needs to understand what
Inkscape does and why she should use it

in certain cases, I’m sure there are lots of
people who need to know that Inkscape
is more appropriate for some tasks than
other graphics or drawing programs.

GOOGLE THIS, EXTEND THAT
I use Google constantly, which is why I
love having the Googlebar article in this
issue of TUX. Unfortunately, the
Googlebar add-in didn’t work very well
for me. I suspect it is because I’m using
KDE 3.4.2 instead of 3.3.x, which is what
most people probably have installed on
their systems.

But then the author mentions that
there is a similar plugin extension for the
Mozilla Firefox browser. How do you
install extensions for Firefox? It’s easy—
even easier than installing extensions for
the e-mail client Mozilla Thunderbird.
Because it is a bit more difficult to install
extensions for Thunderbird, we include in
this issue a tutorial on how to do exactly
that—install extensions in Thunderbird.

As Editor in Chief, I get tons of press
releases in my inbox. I get so many that
they obscure the more urgent mail. I used
to use a character-based program called
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WE’RE NOT DONE MAKING TUX THE BEST IT CAN BE, BUT THIS 
ISSUE COMES CLOSER THAN EVER TO MEETING ITS GOALS.
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Mutt because it allowed me to write
macros to move press releases from my
inbox to a sub-sub-folder called (who’da
thunk it?) “Press Releases” with one key-
stroke combination. I hate having to drag
and drop messages to folders or use the
context menu to move messages to a
folder. I would much rather press a couple
of keys to move messages.

Enter my favorite extension for
Thunderbird, TB Quick Move. This exten-
sion lets you highlight messages and then
press a Ctrl-key sequence to move those
messages into a predefined folder. It isn’t
as flexible as the Mutt approach, but it
doesn’t require macro programming like
Mutt does, so the average user can set it
up easily. I’m not the average user. I can
program Mutt macros. Yet this extension
does the job well enough that I now use
Thunderbird for e-mail more often than I
use Mutt.

I NEVER METADOT I DIDN’T LIKE
We have a terrific case study of Metadot,
an open-source browser-based Web-
authoring tool. I was skeptical about
accepting this article, because it came
from someone who represents Metadot.
So I downloaded Metadot and used it to
create a Web page of my own in order to
see if it was worth publishing the article.

I discovered that it takes a geek to

install Metadot (or at least someone who
is not afraid of the command line and can
follow instructions well). But once it is
installed, it is easy to turn the reins over
to average users and let them create and
maintain a Web site. So now I can vouch
for the fact that Metadot is an excellent
choice for the customers mentioned in
the case study. In fact, we’d like to pub-
lish a “how to use Metadot to create and
manage Web sites” article in the future.
This article would not address installation.
It would assume the package is already
installed and ready for the average user
to tackle.

MANGO PATHOLOGY
There are even more things to appreciate
in this issue than I can list. Mango Parfait
answers some interesting questions while
ripping a new one for GNOME. I admit
I’m no fan of GNOME, but Mango’s
hatred of GNOME seems almost patho-
logical. I can’t disagree with her reasons
for hating GNOME, though, and I’m sure
she exaggerates her opinion for the fun
of it.

But that’s not why I like this month’s
Mango Parfait. In this issue, she explains
something I always wanted to know—
how to create file associations in KDE
the right way. It’s a bit of a tedious
process, but it is one well worth learn-

ing. For all its other faults, I admit
GNOME actually makes this task easier
(although, as Mango points out, GNOME
doesn’t make use of the end result as
well as KDE does).

THE BOTTOM LINE
The moral to this story is that I’m proud
to see TUX improving with each issue.
Don’t take this as shameful self-promo-
tion. My part in the process is just a lit-
tle piece in the puzzle. My job is to lis-
ten to you readers in order to set the
tone and shape of TUX to suit your
needs. I’m just a conduit. You are the
leaders. Of course, the talented authors
are the ones who make the chosen arti-
cles compelling. And the hard-working
team of folks at SSC must know magic,
because I can’t imagine how they man-
age to make TUX such a magnificent
work of art each month.

Keep talking, and we’ll do our best to
listen. When the competition wakes up
and realizes that there are new Linux
users out there who need a magazine like
TUX, we will no longer be the only maga-
zine for new Linux users. But with your
help, we’ll always be the best.�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and Linux analyst for Evans Data Corp.
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More GNOME Coverage
I read the latest TUX today, and somebody asked
the same question as me. Why not more GNOME
coverage? Your response was that KDE is the pref-
erence of most new users. What distro are they
using? Because in another breath, you heartily
recommend Fedora, which uses GNOME as its
standard desktop. And that’s not even mentioning
the popularity of Ubuntu.
--
Robert Holmes

KDE reaches the broadest audience, therefore
TUX spends more time on KDE than GNOME.
Despite her disrespectful method of doing so,
Mango is correct in quoting my reference to
Evans Data Corp. research in this issue. The
number of Linux developers using KDE is
increasing. The number of Linux developers
using GNOME is shrinking. This is a trend that
has persisted over at least the past 18 months.
Linux developers are more “geeky” than Linux
desktop users, and they are more likely to use
GNOME than average Linux desktop users. So if
this trend exists in the developer segment, it is
difficult to imagine that “non-geeky” Linux desk-
top users aren’t following the same trend.
Indeed, it is likely that the trend is even more
pronounced among Linux desktop users.

Both Fedora and Ubuntu support KDE (there is
even a special Ubuntu KDE distro called Kubuntu).
Fedora doesn’t support it well—yet, but the places
where Fedora falls down in KDE probably won’t
matter to most desktop users.

We do not ignore GNOME, but the only way
GNOME will become the primary focus for TUX is
if GNOME ever has more users than KDE. If you
like GNOME, use it. You don’t have to follow
Mango’s advice or take her opinions to heart. But
TUX will still focus on addressing the majority of
readers.—ED.

OpenOffice.org
Although I am very glad OpenOffice.org is
around, free and improving, there are many things
it needs to be close to Microsoft Office capability.
For example, In OpenOffice.org Calc there is an
open issue to include multiple x ranges in a single
plot. In other words, a way to plot different x,y
sets of data on the same plot that Excel allows
currently, and has for a while, but Calc doesn’t.
Also in Impress, if I want to include more than
one graphic image to be inserted (select more
than one at the same time) it does not allow it,
but that is something Powerpoint has allowed
for many years. It is a wonderful thing to be
able to open most Microsoft Office files in
OpenOffice.org, but many features are still lost in

the translation. I’m sure the new 2.0 version may
help in some of these areas, but I’m also sure oth-
ers will wait until later. I think it would be good
for TUX to include both the capabilities and limita-
tions in the articles on OpenOffice.org, but in any
case, I think TUX is great! Please keep up the
good work.
--
Richard Sims

Don’t Be Afraid of the Terminal
Window
I love this magazine. It reminds me that using
Linux isn’t just about figuring out how to do
everything I did in Windoze...but also about all
the additional things I can accomplish with Linux.

I have been surprised by the extent to which the
magazine has shied away from using the termi-
nal window. I think it’s a disservice to the new
user (like myself—I’ve been using Debian for
about two months), because it’s frequently the
easiest way to do something, and I don’t think
we need to be scared of the term window.
Unfortunately, when I’m running from site to
site, trying to figure out how to fix a problem I’m
having, I end up rotely copying commands from
a tutorial without any understanding of what
they mean or what I just did. Although this
method (surprisingly enough) works for me quite

LETTERS
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frequently, I hardly learn from it because I don’t
understand what I’m doing.

Most of us new Linux users were pretty experi-
enced Windows users—we could make Windows
work for us. It’s disconcerting to be set down in a
new environment where things are dumbed down
for us. I haven’t found a quick tutorial/reference
for Bash that I like—I bet TUX could do something
like that: “50 Commands Every Linux User Ought
to Know”. Besides, it’s standard for all distribu-
tions. When it comes down to it, it’s frequently a
lot harder to figure out how to do something
graphically than it is to do it with a one-word
command. I don’t think TUX should shy away
from the simple way of doing things, even if it
means that the answer is not a point-and-click
answer.
--
Sydney Nash

TUX approaches tasks this way. If there is a
point-and-click method to accomplish some-
thing, that’s the approach we take. If there is no
other way to accomplish something than to go
to the command line, we include instructions 
for the command line. In addition, we are more
likely to resort to a command-line instruction if it
does not require that the user log in as root. At
this point, however, Linux has matured to where
it is pretty easy to do almost everything with
point and click.

Our intended audience is not unlike a Windows
desktop user audience. Windows users rarely (if
ever) do anything at a command prompt. Many
people outside the TUX readership might benefit
from something like “50 Commands...” That isn’t
our intended audience, however.—ED.

TUX in German?
Are there any plans for providing TUX magazine
localised, especially in the German language? I
was just going to test my translation skills on a
randomly chosen TUX magazine article.
--
Rene Schmidt

If TUX readership keeps growing at the current
rate, we’ll eventually look at translating it into dif-
ferent languages.—ED.

Stuck on Dial-up
I love what you’re doing with TUX. Keep up
the excellent job! I have a request. It seems
that everyone believes that broadband is every-
where—it isn’t. I’m still stuck on dial-up, and
I’m sure a lot of your readers are too.
Downloading packages and apt updates are a
bear. How about a winmodem (slmodem)
howto and a coping with dial-up article?
--
Dennis Sorenson

Sounds like a good idea.—ED.

More Help with MEPIS
The article by Roy Brander of Calgary [June 2005
issue of TUX] is excellent and very informative;
however, I would like to see similar detailed
instructions on how to install MEPIS 3.3 Simply on
a separate second hard disk (not touching my Win
XP, which is on hard disk #1).

There was an article about dual-booting by
Mango a few months ago, but it was too vague
and not detailed enough. For instance, I don’t
know where GRUB will be installed, will it be
on hard disk #1 (Win XP) or on hard disk #2
(MEPIS 3.3)?

I especially bought and installed a second hard
disk (40GB) for the purpose of installing MEPIS
3.3 separately, away from Win XP), but I’m still
scared that I will loose my Win-XP in the
process—and this I want to avoid at all costs. Your
help will be very much appreciated.
--
Charles Keller

See answer to letter below.—ED.

More on Multiple Distros
TUX is terrific! Let’s hope it’s here to stay. After
reading issue 5 [August 2005], I have to agree
with your reader, John [see the “Multiple
Distros?” letter on page 15] that there is a mas-
sive lack of information regarding the installation
of multiple Linux distros on a single machine. I
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have Red Hat 9 co-existing with Fedora 4—now,
but only after mishaps, mayhem and misery (and
I’m a Networks Engineer).

The great bulk of the information out there is
geared toward Linux and Windows co-existing,
with almost no guidance for multiple open-
source installations. This seems to me a massive
oversight on the part of the Linux community 
as a whole. Why should users choose between
distributions, when there are so many flavours
of Linux to sample?

The falling prices of large-capacity hard drives pro-
vides users ample room to add more than one dis-
tro, so why hasn’t the Linux community jumped
on the idea of having one, or two or ten different
types of Linux on a single machine?

Although there can be only four primary parti-
tions, the number of logical partitions has no
such limitations, and a Linux advantage is that
it can be booted from logical partitions (where
Windows can’t). This being the case, where’s
the how-tos for a Linux-only multiboot? The
documentation included in each distro makes
scant mention at best.

Nicholas Petreley, in his “An Evolution of Linux
Distros” article [also August 2005], narrows the
choice down to three flavours of Linux. What’s the
harm in showing how to install all three? Surely
many Linux users would be eager to try such

options were they widely known and easily avail-
able. TUX should take the initiative and feature
the process, highlighting the partition managers
employed and their attributes.

PS: To get a free copy of the commercial SUSE dis-
tro, e-mail linux_community@novell.com.
--
Nizar

We’ll pass this question on to Mango. If she can’t
handle the question without writing an article-
length piece, we’ll do an article on it.—ED.

Page Numbers?
First, I like TUX magazine very much—very
informative and right to the point. I like your
format (landscape instead of portrait). It fits my
screen much better. However, I would like to
submit two items:

1) If I want to print an article from TUX magazine,
for instance “How to install MEPIS 3.3 Simply”,
pages 24–29, I have to ask for pages 25–30.
Why? I am using an HP printer HP-890C.

2) Would it be possible to identify the page num-
bers as: http://www.Tuxmagazine.com page 24 -
June 05 (or issue 3-Jun.05)?

You are doing an excellent job, congratulations!
--
Charles Keller

Acrobat considers the cover to be page 1. TUX
considers the table of contents to be page 1.
That’s what causes the difference.—ED.

Crystal-Report-Alike
I haven’t had chance to try this yet, but
http://datavision.sourceforge.net/index.html
looks promising.

As for the magazine, I like it a lot, except for
the Mango Parfait section. I really, really hate
her style, read it the first time and didn’t like it,
got so hacked off a short way into it the second
time that I couldn’t be bothered to read the rest
of it, and I refuse to read it now. Now, I’m not
suggesting that you pull her column—after all,
some readers doubtless like it as it is. But given
the nature of the medium, how about providing
two versions of that section, one with Ms
Parfait’s humour included, one without? Should
be easy enough to do. It’s not that I’m averse to
humour in computing literature—far from it, just
that Ms Parfait’s I find particularly unfunny and
just plain irritating.
--
Esme

Kanotix
I am glad to see a magazine for Linux newbies like
me! I had tried Corel Linux years ago, but I gave
up because of problems getting hardware (even
my printer) to work.
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A couple of months ago, an article at
http://www.arrl.org (the Web site of the largest
Amatuer Radio organization in the USA) about
Harve’s Hamshack Hack (a remaster of the
Knopptx live CD aimed specifically at Ham
Radio Operators) got me thinking about Linux
again. Since Harv recommends that you do not
install his “hacked” version of Knoppix to hard
drive, I started looking at other distributions 
of Linux.

After trying Debian Sarge (had major printing
and other hardware problems), Mandrake 10.1
(install had major problems with hardware
detection), aLinux (no automatic hardware
detection and I never got to a desktop),
Knoppix (a few minor problems, easily fixed
with a little research and by reading the
Knoppix forums), I discovered Kanotix. Kanotix
is a remaster of Knoppix in which the few
minor problems I had with Knoppix have been
fixed. It is also closer to Debian SID (not totally
sure what that means) and is meant to be used
either as a live CD or installed to hard drive
(Knoppix is meant to be a live CD and is not
meant to installed to hard drive according to 
its author).

I believe that Kanotix is one of the best distribu-
tions for a beginner like me, as it just simply
works without any of the problems I had with

other distributions. I did try Kubuntu (I like KDE
much better than GNOME) and found that it lim-
its me too much to its setup. I realize that one
should log in as root only when absolutely neces-
sary in Linux, but I want that option available for
the few things I might need it for. In Kanotix, I
have File Manager as Superuser, and a Root
Terminal that allows me to do most of what I
need root access to do. Programs like Kpackage
(and some others) ask me for the root password.
The absence of these tools in Kubuntu makes it
unsuitable for me.

I would like to see TUX magazine do a review of
Kanotix and some of the other live CD distribu-
tions of Linux. I think this would be of great use
to those considering trying Linux. The live CD dis-
tributions seem to be aimed more at those of us
who want to run Linux on a standalone PC, or a
small home network. Thanks for a great and very
useful magazine!
--
Martin

Go TUX!
It took me some time but I finally found out how
to send a letter to the editor! I think this address
should be very prominently displayed on the cover
pages of TUX.

I often read TUX while logged onto Windows

using Adobe (Oh horror! But there are good rea-
sons for this in that I do use MS Office for com-
patibility with others). When the TUX file is clicked
to open, it quite usefully comes up full screen.
However, there are only three Adobe commands
that are really necessary and these aren’t visible
full screen:

Bring up the tool bar: F8

Bring up the Adobe window: Ctrl-L

Change size: Ctrl-+/-

Reading TUX is about the only time that I use
Adobe full screen, and so I wish there was
some way to remind me. I do forget those
commands.

I’ve said it elsewhere (and voted!), but may I
repeat how much I like TUX? I have used Linux
since the early 1990s when my computer was so
advanced that Red Hat gave up, and thus I actual-
ly started with Slackware, which was then more
up to date. I have a full set of Linux Journals, but I
guess I can still be described as an amateur, not a
professional, and TUX suits me fine. Keep up the
good work!
--
James Silverton
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On Value
As a professional in the quality field and a certi-
fied Quality Engineer I have to take exception to
Scott Bicknell’s reply to John Knight’s “The Last
Word” article [see Letters, August 2005, page 13].

The perception of quality is inherently tied to
the concept of VALUE, and this is what I
believe John was trying to point out in the
original article.

The “godfather” of quality, Juran, defines quality
as “fitness for intended use”.

The American Society for Quality defines quality as
“a subjective term for which each person has his
or her own definition. In technical usage, quality
can have two meanings, 1) the characteristics of a
product or service that bear on its ability to satisfy
stated or implied needs, and 2) a product or serv-
ice free from deficiencies.”

Value also has many definitions and Webster notes
it as “1) an amount, as of goods, services, or
money, considered to be a fair and suitable equiva-
lent for something else; a fair price or return, 2)
monetary or material worth, and 3) worth in use-
fulness or importance to the possessor.”

The concept of value has many sides. Does the
product meet my needs? Does it meet my expec-
tations for reliability? How much time will it take

to maintain? Can I find support for this product?
Can I interact with others that might not be using
the same product?

Sure, we can expect open-source software to be
free of defects and avoid wandering off into the
land of blue screens and re-boots, but we shouldn’t
be confusing that with all the bells and whistles
that come with a “premium” commercial product.

A spanking-new BMW may have more options than
a Dodge Neon, and it may arguably be built to a
higher standard but at 3–4 times the cost of the
alternative, the real question is one of VALUE. If
offered both of these vehicles for free, which one
most of us would be driving away in is pretty clear.
Once you have to start reaching into your pocket, it’s
all about VALUE. Scott Bicknell seems to be one of
those people that believes when handed a Neon we
should be complaining that we didn’t get the BMW.

It seems that he did not completely miss the point
of the original article, but the arguments he pres-
ents are ones of features and not necessarily quality.
To expect commercial software and free software to
run side by side, feature for feature is absurd.

If you want a fine French meal you shouldn’t be in
the McDonald’s drive-thru, and you can expect to
pay accordingly.
--
Mike Meyer

TUX in .txt?
Your magazine is excellent, so I want to archive
copies of it. At times, I would like to print out
pages, as well. Both operations cause me prob-
lems. I suppose it is too much to ask that you
create a .txt version and make it available. As
much as I like the .pdf files, they are bulky
(bzip2 is no help) and contain a lot of eye candy
that I don’t find necessary for reference materi-
als. BTW, you might tell your readership how
you actually assemble TUX. Do you use any
word processors? LaTeX or some flavor thereof?
That would be interesting.
--
Lawrence Barnes

You can convert TUX to text yourself. There are
utilities out there that will convert PDF to text,
PDF to HTML and so on. I can’t tell you where
to get these utilities without knowing which
distribution you’re using. I’m sure you can find
them if you poke around your distro’s package
resources. The command for converting PDF to
text is pdftotext You may not like the results
you get, depending on the target format, but it
does the job.—ED.

Yay Linspire!
Just finished reading through issue 5 and really
enjoyed Ricky Freedlander’s article “Linspire Is
Filled with Linspiration”—so much so, that I
downloaded the Linspire Live CD and am using it
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right now! I’m impressed!

I have to agree with Rick. For $49.95 (or $19.95
for the budget-minded ), Linspire’s CNR makes a
lot of sense! I’ve wrestled with Mandrake’s
RPMs long enough. Until Auto-Package is adopt-
ed, there is no real reliable way for installing
and updating software for newbies like myself.
CNR takes care of it all. I’m going to adopt
Linspire and pay the subscription fee. It’s a small
sum when you think of all the time newbies
waste in trying to compile programs, finding file
dependencies and so on.

My only question is, will Linspire play DVD movies
out of the box? Trying to find PLFs for DVD replay
has been the biggest hassle with Linux. I’ve had to
debug Mandrake to get it back up and running
(again, due to my not understanding software
installation outside of the RPM arena) and lost
those files. ARRRGGGHHH!

Well, yes, Linspire solves this, too. For only
$9.95 (with a Gold Subscription) you can
download The Linspire DVD player (looks like
Xine). From their catalog: “The Linspire DVD
player is a software multimedia player that
includes legal, licensed commercial-quality
codecs and auto-detection of DVDs to enhance
the DVD playback experience under Linspire
4.5 and higher.” Linspire, here I come! CNR is
the best solution. (BTW, the spell-checker that

comes with Linspire’s Internet browser is the
best I’ve seen!)
--
Mark Szorady

Tomboy
Yes, dear Editor, you can assure Shannon Baker
that Tomboy can be used under KDE too [see
the July 2005 issue]. As a result of his article I
dug into my Debian repositories and found it,
d’loaded it and later found it installed—what a
stunning service Debian’s apt-get is—in my KDE
Utilities menu. I then noticed it was in the
Panel as well.

It was in use from within three minutes of starting
it; it would have been sooner, but I had to go to
the Tomboy site to be told that it was run from
the Panel icon <blush>.

Excellent mag, sir. I find it useful and readable...and
I think I’m in love with Ms Parfait <further
blushing ensues>.
--
ChrisM

Pronunciation Tips?
I’m a Windows expert learning Linux and your
magazine is a great help. I print it out, keep it
on my PC, and have subscribed to the RSS feed.
But, if you want newbies like me to talk about
Linux, how about a little help with the pronun-

ciation? Xine? GNOME? GNU? SUSE? Maybe a
glossary with pronunciation key on the site and
some inline help? Also, your URL should be a
more prominent part of the magazine for those
who have received it indirectly. Keep up the
great work.
--
len

I don’t worry about how to pronounce things. I
pronounce Xine, GNOME, GNU and SUSE “gurgle-
blottom”. Nobody knows what I’m talking about
either way.—ED.

Basic Programming?
Perhaps my hours of Web searching have missed
this, but is there a SIMPLE programming environ-
ment for Linux? As a hobbyist in a Windows envi-
ronment you usually arrive at Microsoft’s Visual
Basic for simple and “easy” programming. It is
easier to learn for older brains like mine than any
of the flavours of C—especially when they taught
Pascal, Basic and machine-level coding when I
went through school.

Is there a development environment out there
for Linux that lets a hobbyist plunk down some
graphical controls, string together some glue
code and create a “recipe indexer”? For all my
searching, all I have found are very powerful
environments for the very knowledgeable.
Perhaps you at TUX might have the answer—or
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at least could confirm that we, the most BASIC
of programmers, are unable to join in the 
Linux fun.
--
Alan

There are several such programs. We’ll consider
doing an article covering some of them.—ED.

Help with Drivers?
What is the best Linux distribution? I’ve been
dealing with Linux since I swore off Microsoft
(about the time windoz me came out). I’ll switch
to a Mac before I come back to Windows. I really
like the concept of open-source software, and
wish I was smart enough to give something back
to the Linux community.

I’ve tried several distributions over the past several
years, but have yet to find one that is perfect for
me. I’ve installed Red Hat, SUSE, Xandros and
Fedora core 3.

Each one seems to have some quirks with it. Red
Hat seemed to work the best, but since they’ve
decided not to support the desktop, I had to
move to another distribution.

SUSE is pretty good, but has several issues. The
main ones that I’ve found: the hotplug feature
does not work when I plug a device in to a USB
port, and sometime causes a reboot of the sys-

tem; I am unable to use my Kingston Flash drive
with it; the system freezes up (I thought that
this feature was supposed to be unique to
Windows) when I try to rip a CD onto my hard
drive using my NEC DVD drive; my sound Blaster
Live! 24-bit PCI sound card refuses to work (I
had to install an old Yamaha card in the system
to get sound); the scanner on my HP psc-750
all-in-one printer is not recognized, although the
printer works fine (I am able to use the scanner
by installing the HP software using the WINE
application). Sometimes the system seems to
hang up during boot up, during the hardware-
detection phase. I have version 9.2 installed on
my computer (Athlon 3000+ 64-bit processor
with 1G of DDR333 RAM, 120G IDE hard drive,
ATI Radeon 9200 pro graphics card, NEC ND-
3500 AG 16X DVD-/+/R/RW dual-layer drive).
SUSE seems to be pretty stable, but is not that
user-friendly. They do a very good job of making
updates available on-line!

I read an article about Xandros, which sounded
pretty good, so decided that I’d like to try that. I
had a friend with a fast Internet connection
download the OCD version and burn me a CD. I
installed it on my machine, and was so
impressed after a month that I purchased the
Deluxe desktop version (version 3). It didn’t have
the flexibly of SUSE, but was very easy to use
(the file manager is one of the best I’ve ever
seen). When I tried to rip a CD to my hard drive,

however, my system froze up. Also, when I tried
to install the firewall, I was unable to send or
receive e-mail or even get to my ISP (even with
all of the available services enabled—very secure
indeed, but totally unusable). Also, my dial-up
connection was disconnected periodically, even
during downloads (I thought this might be the
fault of my US robotics model 5610B modem,
but I never get disconnected during the middle
of download when I am using the SUSE distribu-
tion). The thing that caused me to quit using
Xandros was when my system became
unbootable after I installed their service pack 2
upgrade (which I had to have downloaded and
burned to a CD by a friend—my dial-up connec-
tion was unable to handle a 300M download).
Xandros has a very good support forum, but I
hate to have to fight every piece of hardware or
feature I try to use!

I recently installed Fedora Core 3. The desktop
looks intriguing. However, the hardware detection
leaves something to be desired: neither my
modem nor my printer were detected during
installation. Also, when I shut the system down,
the computer doesn’t power down (even though
a message is printed on the screen saying SYSTEM
POWER OFF).

I still consider myself a Linux newbie, even though
I have lots of experience with the OS. I have a
pretty good understanding of the filesystem, but
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lack an understanding of device drivers or how to
install them.

I would appreciate any guidance you can provide
me. I really love your magazine.
--
Dick Stubbs

We wish there was a simple answer to the ques-
tion “Which distro is best?” It depends on what
you like, what you need, and what you’re willing
to pay. We reviewed Linspire in the last issue.
We’ll try to keep reviewing distros so you can pick
the one that suits you best.—ED.

Help with Printers?
I appreciate TUX and find it very useful. I’ve
played around with various Linux distributions
over the years but have never been able to
make a break from Windows, mainly because of
printing concerns (though also the need to run
some indispensable software). Of all the things
that have given me grief in Linux, printing is the
main one. I know I can check lists of suitable or
semi-suitable printers, but many are quite old
models and haven’t been available for years. I
also found that even with printers that are sup-
posed to work well under Linux, that often
wasn’t quite the case in that some features
really didn’t perform well. I even found some
printers where margins would be consistently
off by quite a bit in such a way that I couldn’t
correct the situation easily. It’s the ease-of-use

issues in everyday tasks (like printing) that I
think need work.

So anyway, I wonder if TUX could devote some
energy to addressing printing and printers under
Linux?
--
John Stafford

We’ve been planning to cover printer compatibility
and similar issues for some time now. We’ll get to
it as soon as we can.—ED.

Stop Comparing
Good magazine, easy read. Thanks for making it
free! However, can’t Linux stand on its own? I
am tired of the constant comparisons and decla-
rations why this or that Linux tool is better than
the counterpart on Windows. As a user of com-
puters from the PDP days, and a new Linux
(Kubuntu 5.04) user, I would rather like to see
articles describing the tools and their uses with-
out comparisons. It is a great experience and I
am enjoying it. In a (totally non-scientific) test,
my 12-year-old niece moved sort of seamlessly
from Windows XP to OS X 10.4 to Kubuntu
without major pain. Her only problem was with
the G5 mouse.

But make your magazine an oasis from the fluff
out there. You guys have something good here:
other Linux mags assume you have all the neces-
sary experience. You guys break it down.

When will there be a user help forum as well?
Please keep all the political and religious stuff out
of what is, I hope, going to be the best new-user
Linux mag out there.
--
Rod Spode IV

A user help form is a good idea for us to toss around.
Meanwhile, you can send questions to Mango Parfait
at mango@tuxmagazine.com.—ED.

Go Mango!
I would just like to give a vote of confidence 
to Mango Parfait. I find her responses witty
and entertaining as well as informative. I hope
she continues to provide her offbeat humor to
the magazine.
--
Christopher

Erratum
Ryan Paul’s photo was incorrect in issue 5. See
below for the correct photo.�
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Thank you again for your questions. I did
not get as many questions this month as
I did last month. Maybe you are on vaca-
tion? If you come home and read this,
send me a question.

I am glad my almost-boyfriend Otaku
likes KDE. He does not like the same
manga and anime as me, but at least we
are compatible on the desktop. I think he
has a crush on Witch Hunter Robin
because he has her picture for KDE wall-
paper. He thinks I am not jealous because
Witch Hunter Robin is an anime charac-
ter. He forgets I am an anime character
too. I think I am prettier than Robin. She
is just more realistic.

My doofus-in-chief has access to
Evans Data Corporation research data.
He says there is a trend. More and more
Linux developers use KDE and less and
less are using GNOME. Does this not tell
you something? There are more KDE
users than GNOME users. KDE is grow-
ing. GNOME is shrinking. Yet I get more
questions about how to do things in

GNOME than questions on how to do
things in KDE. I wonder what that
means? Hint: this is a rhetorical question.

Hint to GNOME developers: some of
GNOME is okay, but most of it works like
you hate users. Some of GNOME runs
like you think users are too stupid to
wipe themselves. What do you do for
these users? You do not make GNOME
easy. You just take away their toilet
paper and force users to wipe themselves
your way. Some of GNOME runs like you
want users to suffer. The file open and
save dialog is worse than bamboo shoots
under fingernails. Better to call Nautilus
an attack from space invaders than a
spacial file manager. Here is my advice.
Make your monkey-brain environment a
configuration option if you want to keep
using GNOME your way. The rest of us
are not monkeys. Give us a default desk-
top for humans. If you keep having no
clue, less and less people will use
GNOME, and the only GNOME users will
be monkey-brain GNOME developers.

Q Dear Mango, I am using SUSE 9.2 with
the GNOME interface for my office

work. I edit and create lots of VB Script files
for Windows server management and other
tasks. How can I associate the .vbs extension
to an edit program?—Anand

A I do not use SUSE 9.2. I use SUSE
9.3. If these instructions do not

work for you, upgrade to SUSE 9.3. It
may not be convenient for you, but it
will sure save me a lot of trouble. But
there should be very few differences in
these instructions, if any, even if you are
a reader who is not using SUSE at all. All
you need to do is run a recent version of
GNOME. Here is better advice. Ditch
GNOME and use KDE. You will thank me.

To answer your question, open up a
folder where you have stored some of
your scripts. Right-click on one of the
icons for your .vbs script and choose
Open with Other Application from the
pop-up menu. You will see a list of appli-
cations like the one shown in Figure 1.

Q&A with Mango Parfait
Mango explains how to create file associations in GNOME, how to initialize a new Linux install and how to install 
new packages in Fedora—all while dropping subtle hints about her opinion of GNOME and Emacs. MANGO PARFAIT

http://www.tuxmagazine.com


You can select an editor from this list. You
can select the default text editor (which is
what the figure shows). You can select
another editor from the list. If you do not
see your favorite editor in the list, you can

click on Use a custom command to set
your favorite editor as the default applica-
tion. Then Click Open.

From now on, GNOME will open your
.vbs files with your text editor when you
double-click on the icons. Maybe it won’t
work the first time you click on the same
icon you used to make this setting.
GNOME is sometimes slow-witted when it
comes to recognizing a change you just
made. You may have to refresh the folder

(Ctrl-R or View→Reload from the menu)
before it understands that you set a
default editor for this file.

You can add other editors to the list
the same way. Right-click on the icon
again and select Open with Other
Application. This time you should see a
window like the one shown in Figure 2.
Here you have to click on All Applications
to see a list of applications. Last time it
listed all applications automatically. Why
is it different now? Because the GNOME
designers work very hard at torturing
users with inconsistency and confused
designs, and they are very talented in
these areas. Anyway, click on All
Applications and pick another editor. I
picked X Emacs, the editor of choice for
masochists.

CHANGING THE DEFAULT EDITOR
Now you can choose between two edi-
tors as the default editor for .vbs files.
Right-click on the icon and select
Properties from the pop-up menu. You
should see a window like the one shown
in Figure 3.

Now is a good time to change the
default icon for .vbs files so it is easy to
find them in a folder. But I am assured
that you can figure out how to do this, so
I will go on about associating editors.
Click on the Open With tab to see some-
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thing like what you see in Figure 4.
Now click on the little dot next to
the editor you want to be the
default editor. I advise you to try X
Emacs as the default editor for .vbs
files. You can now enjoy weeks of
pain and suffering while you memo-
rize finger-breaking Ctrl-key
sequences. Now, click the Close but-
ton. Press Ctrl-R or select
View→Reload from the menu so
that GNOME will catch up with what
you are thinking.

HOW TO DO THIS IN KDE
You can take a quick-and-dirty
approach to get the same results in
KDE, but here is the best way to
associate files in KDE. Open the KDE
Control Center. When you see the
window, click on KDE Components
in the list on the left. Then click on
File Associations in the list on the left. You should see
something like what you see in Figure 5.

Click Add... and a little dialog should pop up. Select
Text from the group list, and then type in vbs as the file
type. Click OK. Now your Control Center window
should look like the one shown in Figure 7.

You should see a dialog like what you see in Figure
7, except Figure 7 has everything completed already.
Yours will be blank until you follow the next steps.

Click on the Add button in the Filename patterns
section. Type in *.vbs. Click on the Add button in the
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Figure 4. Setting a Different Default Editor

Figure 6. Defining the .vbs File Type

Figure 5. Setting File Associations in KDE
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Application preference order section. You
should see a dialog like the one shown in
Figure 8.

I selected the most excellent Kate edi-
tor, as you can see from the picture. Click
the OK button. The dialog should now
look like the completed one above (Figure
7). Click Apply and then close the Control

Center.
Now when-

ever you click
on a .vbs file,
it will open
Kate as the
default editor.
This approach
may seem
more compli-
cated, but it
has benefits
you can’t get
from GNOME.
When you use
KDE and cre-
ate the .vbs
file type, you
can associate
other actions
with the file
besides what
happens when

you click on the icon. You can customize
KDE so that you can right-click on a .vbs
file and choose Actions...→Compile,
which launches a compiler specifically for
Visual Basic Script. This option will not
show up for other types of files. You can-
not do the same thing in GNOME. I can
explain how to do all this in KDE. Maybe I
will explain in a future issue.

Q Being a novice to Linux, I am won-
dering exactly what you do or rec-

ommend doing after installing Linux. I
believe [I recall] reading that one of the
first things to do is set up the locate com-
mand by running some other command to
create the database it will use to find
something you’re looking for.—+J

A I like your name +J. You do not tell
me what J is for, but it gives me an
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Figure 7. Defining an Application for Text/.vbs

Figure 8. Choosing Kate as the Default
Editor
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idea. I think of myself as Beautiful
Mango, so you inspire me to change my
name to +BM. Do you like? Maybe some-
day I will do that.

Okay I will answer your question. For
readers who do not know about locate,
here is what it is and how it works. This is
a command that tells you where you can
find a file or directory. You can type
locate prince_of_tennis.avi to find
that file. The locate command will not
find only that file, it will find everything
that matches this string. This can give you
too much information if you are not care-
ful. If you type locate share, it will find
too many files because it will match and
find every file and directory located in the
/usr/share directory. There are other ways
to find a file or directory, but locate is
faster than most other ways because it
does not really search your hard disk. It
takes a picture of your files and directo-
ries and keeps the picture in a database.
You run locate and it searches the data-
base, not the files.

There is one problem with locate. If
you change files or install new programs,
locate will not find the new directories
and files until you update the locate
database. You may have other databases
on your system that make finding things
easier and faster, and they need to be
updated on a repeated basis. It depends

on which distribution of Linux you 
are using.

Here is the easy way to set up all the
databases in your distribution of Linux.
Do not turn off your computer for a 
couple of days. See that word daily in 
the command below I provide for geeks?
That means your computer will run this
command every day at a certain time.
The exact time depends on many things,
but don’t worry about the exact time.
Just let your computer run for a day or
two and every daily update will happen
automatically.

Here is the hard way to update the
database manually (this exact command
works on most Linux distributions but
may not work on yours). Here is what you
need to do:

$ su -
<enter your root password>
# /etc/cron.daily/slocate &

I like the easy way better. It uses more
electricity. So what? I leave my worksta-
tion on all the time anyway.

Q Linux needs to be easier for newbies
to use at a basic level. For example,

I have a technical background, am A+ cer-
tified, am of above-average intelligence
(not brilliant) and I have a hard time with

Linux. I wonder how the average user is
ever going to cope with Linux. My ques-
tion: how do I install a program that I
have downloaded onto Fedora Core 3?
—Tom Cranston, a.k.a. borgward

A Your problem is not a Linux prob-
lem. It is a Fedora problem. The

default install of Fedora Core makes it the
most pitiful distribution for installing
packages. Most Linux users who use
other Linux distributions do not find it
hard to install new programs.

Other distributions have friendly
installer programs like Kpackage or
Synaptic. Fedora gives you only a menu
selection called Add/Remove Applications.
This will help you install programs the
Fedora people think you should be able
to install. The only way to use this pro-
gram to install a package the Fedora peo-
ple did not think you should install is to
perform an ancient Japanese mystic ritual.
You will need the organs of various exotic
lizards, a set of chopsticks and a rare
brand of pantyhose. I am guessing you do
not want to go that way.

You can download Fedora programs
and install them, like you say, but that is
the worst way to install Fedora programs.
Do this only if you cannot install the pro-
gram you want any other way. I will tell
you more later.
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INSTALLING SYNAPTIC
There are better ways to install Fedora 
programs. Here is my favorite. The bad part
is you must open a terminal window or
console and log in as root. The good part 
is you need to do this only one time. It is
needed only to get started. This is what
you need to do. I add one extra command,
yum update, because it is better to start
with a system you know is updated to the
latest software:

$ su -
<enter your root password>
# yum update
# yum install apt synaptic

Each time you run yum to update or
install, it will do some things and then
ask you “Is this ok?” Type y and press
Enter. When yum is finished with the
install apt synaptic command, exit
the terminal window or console and get
back to your graphical desktop.

The Fedora developers are GNOME
groupies [I think the word she is going for
is more like “toadies”—Ed.] and do not
like KDE. The Fedora version of KDE is
stinky, and some KDE functions do not
even work. It is not a surprise that Fedora
adds a way to launch Synaptic in GNOME
but does not add a way to start Synaptic
in KDE. Here is how to create a desktop
icon to launch Synaptic.

CREATE SYNAPTIC LAUNCHER ICON
Right-click on an empty space on your KDE
desktop and select Create New→Link to
Application from the pop-up menu. Now fill
in the first screen so that it looks like Figure
9. You do not have to change the icon to
look like mine.

Click on the Application tab and fill in the
information so that it looks like what you see
in Figure 10.

Click on the Advanced Options button.
A dialog window appears. Check the Run
as different user box. Type root as the
user name, so that the dialog looks like
Figure 11.

Click OK, and then OK again.
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Figure 9. Starting to Create Your Own Synaptic
Launcher

Figure 10. Define how the application launches.

Figure 11. Run this application as root.
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RUN SYNAPTIC
Double-click your new Synaptic icon to
start the Synaptic package manager.
You are not done. Synaptic is a better
package manager than the Fedora
package manager, but right now it still
knows only about the same Fedora
programs you get when you run the
Fedora package manager. It does not
help you to stop here. You need to add
at least one good repository (a place
where you can get other Fedora pack-
ages) to Synaptic.

ADD A NEW REPOSITORY
Here is how to add my favorite repository,
called dag.

Run Synaptic and type the root pass-
word when you are asked for it. Then
click Settings→Repositories from the
main menu. You will see a dialog box
like the one in Figure 12. Click the New
button, and then fill in the empty fields
like I did. You may see that I have
already added a dag repository for
Fedora Core 4, because I run Fedora
Core 4, not 3, which is what you use.
You probably do not want to add a
Fedora Core 4 repository like I did.

Now click the OK button. You may
see a warning that you must reload.
Pay attention to that warning. Click the
Reload button in Synaptic. You should

see many more packages that are avail-
able to you. Look for the one that you
downloaded and install it with
Synaptic. If you use Synaptic, it will
know what other packages it must
install to make the application work,
and it will install these other packages.
If you try to install it yourself you may
have dependency problems.

There are other ways to get the
same results, but they are command-
line ways. I have given you an easier

point-and-click way to find and install
new packages.

THE WRONG WAY
If you go against my advice and down-
load a package, here is how to install it
using KDE. Download a Fedora-com-
patible RPM package and save it to
your desktop. Right-click on the icon
for the package. Choose Open With...
from the pop-up menu. Fill in the dia-
log the way you see it in Figure 13.
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Figure 12. Add the dag Repository
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Type system-install-packages in the
empty field at the top. Make sure to
click the box Remember application
association for this type of file, so you
never have to do this again.

When you click the OK
button, Fedora will ask you
for the root password and
try to install the package. 
I say try, because it can 
be foolish to download
packages and install them
this way. You can make
mistakes and Fedora will
not be able to install your
package.

I said before that Fedora
maintainers are GNOME
groupies [toadies—Ed.]. They
make GNOME easier to do
these things. You can start
Synaptic from the menu (I
think it is under System
Settings). You can install a
package on the desktop easi-
er too. Right-click on the
package and choose Open
with installer from the pop-
up menu.

When you are finished
following my KDE instruc-

tions, you can double-click an RPM file
on the desktop (or anywhere else), and
it will run system-install-packages
automatically.

POSSIBLE KDE PROBLEM
If you have to go through the Open
With... thing again, it is because you
upgraded to a newer version of KDE
and it did not update your personal set-
tings correctly. Either Fedora maintainers
do not care enough about KDE to get
this right, or the KDE maintainers made
this mistake. I do not know.

The only way I know to fix this is to
log out, go to a console (press Ctrl-Alt-
F1), log in and type the command:

$ mv .kde kde.old

This command saves your old configu-
ration directory in case you have data in it
somewhere that you need. But the next
time you log in to KDE, you will see you
lost all your old settings, and you will
have to configure the desktop again the
way you liked it.�

I am a sweet, humble, delicate and very cute
genius who is at your service to answer your
Linux questions. Send your questions to
mango@tuxmagazine.com. I am deeply sorry that
I do not have time to respond to anyone directly
by e-mail, but I will select as many questions as I
can and answer them here.
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Figure 13. Setting the Default Application for RPM Files

mailto:mango@tuxmagazine.com
http://www.tuxmagazine.com


P2P

24www.tuxmagazine.com

Ah, sweet, lazy summertime. We debated long
and hard whether to hold the voting for the
inaugural TUX Readers’ Choice Awards in
August. Some TUX staffers cautioned that our
wonderfully attentive readers would be at the
beach, scaling high mountain peaks—or at
Disney World yet again to stop the youngsters
finally from pestering them.

Lucky for everyone, the nay-sayers were
wrong. We opened up the on-line poll and thou-
sands of you responded with opinions about your
Linux desktop faves. For this, we thank you.
What’s more, we didn’t have to rely solely on the
TUX readers located in the furthest reaches of
Southern Hemisphere who are now hibernating
their way through a long winter. Dear TUX read-
ers, don’t you ever go on vacation? We’re guess-
ing you packed your Treo or Blackberry next to the
beach ball and sunscreen and snuck a TUX fix
when nobody was looking. Were we right? Either
way, we’re pleased that so many of you took part.
And hey, if you didn’t get away for vacation, don’t
feel blue. Here I am writing this article—and it’s
not at the beach on my Treo!

Opinionated TUX readers, you have spoken
wisely, and here is what you said.

22000055  TTUUXX RREEAADDEERRSS’’  CCHHOOIICCEE  AAWWAARRDDSS
Read on to see how your fellow TUX readers voted in our first annual Readers’ Choice Awards. JAMES GRAY
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FAVORITE DISTRIBUTION
1. Kubuntu/Ubuntu: http://www.ubuntulinux.org
2. SUSE: http://www.novell.com/products/

linuxprofessional/overview.html
3. PCLinuxOS: http://www.pclinuxonline.com/pclos

Kubuntu/Ubuntu is literally “the little distro
that could”. In less than one year of existence,
Ubuntu has stepped up to challenge the estab-
lished industry veterans with its usability, inter-
national focus and, of course, its cost—which
is free! To be fair, two of the three top vote-
getters are based on established distros, name-
ly Ubuntu on Debian and PCLinuxOS on
Mandriva. Furthermore, a number of distros
were clustered together after PCLinuxOS,
namely Gentoo, Debian, Fedora, MEPIS and
Mandriva. It just goes to show the degree to
which choice is valued in the Linux community.
How did we get along for so long with one
choice from one company?

FAVORITE DESKTOP ENVIRONMENT
1. KDE: http://www.kde.org
2. GNOME: http://www.gnome.org
3. Xfce: http://www.xfce.org

Here’s a conundrum for you. Ubuntu, your favorite distro, is based primarily on GNOME. However, 
KDE beat out GNOME by a margin of 3 to 1. We can’t explain that one, except to speculate, but we do
know that you folks love KDE. It’s very easy to add KDE to the GNOME-based Ubuntu, so perhaps that’s
what many of you Ubuntu fans are doing. In addition, you love it more than the readers of our sister
publication, Linux Journal. They voted in favor KDE over GNOME at a ratio of only 2 to 1. Hmm...have
you checked to see if the guys at the KDE Project have been slipping something into your water?

FAVORITE WEB BROWSER
1. Firefox: http://www.mozilla.org/products/firefox
2. Konqueror: http://www.konqueror.org
3. Opera: http://www.opera.com/products/desktop

Firefox is to browsers what Ubuntu is to distros—a great new, disruptive piece of software that
caught everyone by surprise. Of course, there was no browser on Linux that was as buggy and inse-
cure as Internet Explorer, so Firefox didn’t wreak as much havoc on the Linux side as it did on the
Windows side. Mozilla simply morphed into something way cooler. Still, Konqueror, the solid, work-
horse KDE-based browser held its own in the voting, coming in second place. We were surprised to
see Opera, which has supported Linux so long and so passionately, come in such a distant third place.
Opera lost to Firefox nearly 10 to 1. We’re curious to hear why you prefer Firefox so strongly. Is it
because Firefox is open source and Opera is not? Is it the features? Let us know.

FAVORITE E-MAIL CLIENT
1. Thunderbird: http://www.mozilla.org/products/thunderbird
2. KMail: http://kmail.kde.org
3. Evolution: http://www.novell.com/products/desktop/

features/evolution.html

According to TUX readers, the classic, text-based e-
mail clients a la Pine and Mutt are on their way to the
computing graveyard in the sky. Instead, the stars of
the e-mail world are the slicker GUI-based clients, such
as Mozilla Thunderbird, KDE’s KMail and Novell’s
Evolution. Thunderbird came out on top by a wide
margin though, gathering nearly twice the votes of
either KMail or Evolution.

Ubuntu Desktop (courtesy of Ubuntu)

Thunderbird Screenshot (courtesy of OSDir.com)

http://www.ubuntulinux.org
http://www.novell.com/products/
http://www.pclinuxonline.com/pclos
http://www.kde.org
http://www.gnome.org
http://www.xfce.org
http://www.mozilla.org/products/firefox
http://www.konqueror.org
http://www.opera.com/products/desktop
http://www.mozilla.org/products/thunderbird
http://kmail.kde.org
http://www.novell.com/products/desktop/
http://www.novell.com/products/linuxprofessional/overview.html
http://www.novell.com/products/desktop/features/evolution.html
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FAVORITE COMMUNICATIONS TOOL
1. Gaim: http://gaim.sourceforge.net
2. Kopete: http://www.kopete.org
3. Skype: http://www.skype.com/products/skype/linux

Gaim was the clear winner of the communications tool category. We find it
interesting that the top two vote-getters are multiprotocol tools. Whereas in
other OSes you typically need a different tool for each protocol, Linux-based
tools are like Swiss Army knives. Here’s yet another example of how much
Linux people appreciate choice. You’ll also notice that Skype came in third
place, but it was a distant third. Have you tried it yet? It lets you make free
phone calls with other Skype members on your computer via the Internet
and low-priced calls to non-Skype telephone numbers—very cool.

FAVORITE PRODUCTIVITY SUITE
1. OpenOffice.org: http://www.OpenOffice.org
2. KOffice: http://www.koffice.org
3. StarOffice: http://www.staroffice.com

OpenOffice.org is so popular that it ate everyone else’s lunch in the productivity
suite category. It beat out KOffice by a margin of nearly 10 to 1. What’s more,
did you notice how StarOffice came in third place? StarOffice is actually based on
the same open-source code as OpenOffice.org, except it comes with an added
database application. Dare we assume that you guys like OpenOffice.org?

FAVORITE MUSIC PLAYER
1. XMMS: http://www.xmms.org
2. amaroK: http://amarok.kde.org
3. Audacity: http://audacity.sourceforge.net

XMMS and amaroK are both excellent music players that received almost the
same number of votes. They also left all the other music players behind. We
were surprised, however, to see that Audacity, a cool program for sound record-
ing and editing, didn’t garner more votes. Audacity isn’t so much a music player
as a music or sound editor, but Audacity also has a strong following and lots of
Web-based resources. Go to the Audacity Web site and check it out.

FAVORITE MOBILE TOOL
1. gpilot: http://linux.about.com/library/cmd/blcmdl1_gpilot-install-file.htm
2. JPilot: http://www.jpilot.org

Only a fraction of TUX readers voted in this category, and the two top vote-
getters were close. Is it because only a handful of you synchronize your Palm
Pilot with your Linux box? Or, are TUX readers not Palm users? Perhaps you
use other apps that we didn’t list? We’re curious to know.

FAVORITE DIGITAL PHOTO MANAGEMENT TOOL
1. digiKam: http://www.digikam.org/Digikam-SPIP
2. gtkam: http://www.gphoto.org/proj/gtkam
3. F-spot: http://www.gnome.org/projects/f-spot

The fact that digiKam won this category is not surprising. The app is arguably the most
advanced and best-supported digital photo management tool for Linux right now. It probably
didn’t hurt either that digiKam was reviewed in the August 2005 issue of TUX. We don’t really
have that much power over you, do we? You’re getting sleepy...very, very sleepy....

digiKam Main Screen (courtesy of the digiKam Project)
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http://linux.about.com/library/cmd/blcmdl1_gpilot-install-file.htm
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FAVORITE MEDIA PLAYER
1. MPlayer: http://www.mplayerhq.hu/homepage/design7/news.html
2. Kaffeine: http://kaffeine.sourceforge.net
3. XINE: http://xinehq.de

Although MPlayer received the most votes for favorite media player, both
Kaffeine and XINE polled well. Here’s yet another area where Linuxers have
several excellent choices based on their needs and preferences. TUX readers
are aware of those choices and fully taking advantage of them.

FAVORITE GAME
1. Frozen Bubble: http://www.frozen-bubble.org
2. Tux Racer: http://tuxracer.sourceforge.net
3. Super Tux: http://supertux.berlios.de

Although it has been said by some that Linux-based games are less impres-
sive than those on other platforms, TUXers seem to disagree. Not only did
you vote in huge numbers, but your votes also were spread more evenly
across the different options than in any other category. Although our moth-
ers would chide us for wasting time on games, we are happy to see that the
TUX community takes time to play hard after working hard. Not surprisingly,
the prize in this category goes to the highly addictive Frozen Bubble.

FAVORITE TEXT EDITOR
1. vi: http://www.vim.org
2. KWrite: http://kate.kde.org
3. Kate: http://kate.kde.org

The vi users have it! But by only a slim margin. You also love KWrite and
Kate with nearly equal fervor. Interestingly, enough of you voted for emacs to
put it into fourth place. (Gosh, we certainly have some geeks in the house!)

FAVORITE DESIGN TOOL
1. GIMP: http://gimp.org
2. Scribus: http://www.scribus.org.uk
3. Inkscape: http://www.inkscape.org

The design tool category wasn’t much of a contest, with The GIMP taking
top honors. It’s one of those core programs we all know and love that has
been around for eons, or so it seems. Nevertheless, Scribus has gained in
both popularity and sophistication very rapidly, so keep your eye on this ris-
ing star. Future voting in this department will be interesting to watch.

BEST PLACE TO BUY A LINUX DESKTOP OR LAPTOP
1. Linux Certified: http://www.linuxcertified.com
2. EmperorLinux: http://www.emperorlinux.com
3. Linux Computer Systems: http://www.linuxcomputersystems.com

It’s amazing how many of the big retailers are beginning to jump on the Linux bandwagon, realizing at last how
profitable and enjoyable it can be to sell computers without the yoke of Microsoft. Fry’s, MicroCenter, Wal-Mart, and
others are now unabashed Linux supporters, largely thanks to pushes from Linspire, Xandros and others. Okay, so
that was our plug for the big guys—who really don’t need a plug because they have marketing budgets. Now let’s
talk about the smaller guys, the ones who were passionate about Linux when Linux wasn’t cool. Although you have
myriad choices about where to buy your Linux PC, Linux Certified is your clear favorite, followed by EmperorLinux
and Linux Computer Systems. We applaud these companies, many of which probably started in garages and now are
becoming very serious businesses. To them we say “Never forget that HP and Apple started in garages too!”�

James Gray has
worked in mar-
keting and pro-
motion for sev-
eral Linux com-
panies over the
past decade,
including SUSE

Linux, No Starch Press and now Linux
Journal and TUX. By night, he is work-
ing on his MS degree in Environmental
Science, which lets him play with GIS
and other cool technologies. He wel-
comes your feedback at jgray@ssc.com.
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I’m a prolific digital photographer. Since buying
my first decent camera last year, I’ve come to
think of digital photography as one of my
favourite hobbies. I have a collection of some
5,000 images—many of them requiring some
enhancement—and I’ve found the tools on Linux
for touching up and managing photographs to be
second to none. This month, I show you what I’ve
learned about how to use the basic editing and
photo management functions in digiKam
(http://www.digikam.org/Digikam-SPIP), as
reviewed in the August 2005 issue of TUX.

RED-EYE REDUCTION
Although most cameras now have a mode to min-
imise red eye in flash photography, it still happens
far too often. digiKam comes with a simple-to-use
red-eye correction tool. Open your picture in the
digiKam editor and zoom right in on the eyes. The
more you zoom in to only the red-eye area, the
easier it is to define the area to correct. Once
you’ve zoomed right in, use the mouse to draw a
selection around the iris of the eye. The unselect-
ed area of the photograph will fade out, helping
you focus on the area in which you’re working.
Now, select Red-Eye Reduction from the Fix menu.

If you’ve managed to select exactly the right area
of the eye, select the radio button next to Aggressive.
Click Ok, and repeat the steps on the other eye. You
might find it helps to run the filter two or even three

times over each selection if the red-eye effect is par-
ticularly bad, as in the example photo. The filter isn’t
perfect, but as you zoom back out, you can see a
marked improvement over the original image.

CROP AND RESIZE
If you’re planning to send your images via e-
mail or post them on the Web, you probably
want to resize them to a more Web-friendly or
e-mail-friendly size. You also probably would
like to crop the picture to adjust the position-
ing of the subject or remove unwanted back-
ground details. Cropping means cutting off the
parts of the picture that you don’t want in the
final copy.

Many people are used to cropping their pic-
tures by selecting only the contents of the picture
they want with an arbitrarily sized rectangular
selection. This can present problems later on,
though, if you want to resize the picture.

I like to use the aspect ratio crop tool to avoid
this problem. Suppose you want to be able to resize
your cropped picture to 1024x768, 800x600 or
640x480. These sizes have an aspect ratio of 4:3, so

DDiiggiittaall  EExxhhiibbiittiioonniissmm,,  PPaarrtt  II
How to use digiKam to touch up your photos.

JESSICA HALL
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Figure 1. Red-Eye Correction Tool

Figure 2. After Using the Red-Eye Correction Tool
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if you can crop an area that has an aspect ratio of
4:3, you can resize the cropped picture to any of
these sizes without distorting it. This also lets you
later resize all of your photographs to a uniform size
for posting on the Web, so that if you want to post
all your photos at 800x600, you can do so without
worrying about distorting the pictures.

Open the image you’d like to crop in the

digiKam editor, and select Aspect Ratio Crop
from the Transform menu. Select the aspect
ratio you want from the Aspect Ratio drop-
down box. The example I use here is 4:3, as I’ll
later resize the image to 800x600 for putting
on the Web. In the image window, use the
mouse to drag the frame around, centering it
over the part of the image you’d like to crop
to. You can enlarge or shrink the frame by
dragging its corners. Click Ok when you’re
happy with your result. You’ll see your newly
modified image in the viewing window.

Now you can resize the image to a more
Web-friendly size by selecting Resize from the
Transform menu. Type your desired width into
the width box, and press the Tab key to have
the height box automatically filled in. Click Ok
when you’re finished. digiKam scales images to
fit into the image window by default, so to see
the size of your new image, you may have to
click the Zoom Autofit toolbar button to turn
this option off temporarily. You can also toggle
this option with the keyboard using the A key.

BRIGHTNESS, CONTRAST AND GAMMA
The photograph in Figure 5 was taken standing at
the foot of a runway, snapping aircraft as they flew
overhead to land. Because the plane was being shot
against a very bright sky, the camera took a very
short exposure and the plane is a little dark. To fix
this, we use digiKam’s Brightness/Contrast/Gamma
tool, found in the Fix→Colors menu. Use the sliders

to adjust the brightness, contrast and gamma to
your liking. One tip is that when you increase bright-
ness, you should also increase contrast and perhaps
decrease gamma slightly so that the colors look nat-
ural after the changes.

NOISE
One problem with increasing the brightness of a
dark picture is that it tends to create more noise.
To reduce the speckled appearance, you can use
the Noise Reduction tool from the Fix menu. This
softens and smooths the appearance of the pic-
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Figure 3. The Aspect Ratio Crop Tool

Figure 4. The Cropped and Centered Image

Figure 5. The Brightness/Contrast/Gamma Tool

DIGIKAM MAKES AN EXCELLENT PHOTO LIBRARY. AS
WELL AS THE TRADITIONAL CONCEPT OF ALBUMS, IT
INTRODUCES TAGS FOR PHOTOGRAPHS BY CATEGORY.
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ture by applying a slight blur effect, so use it spar-
ingly. Adjust the sliders until you get the effect
you want based on the preview displayed.

COLOR CORRECTION
This photograph was taken on a bright sunny day
with the wrong settings on my camera! I had set
the camera to optimize the photos for indoor
photography. The preset for indoor photography
adds a slightly bluish cast to give more natural
looking colours under yellow light and produces
rather unfortunate effects outdoors if you forget
to turn it off. You can fix the color balance of a
photograph like this using the Color Balance tool,
found in the Fix→Colors menu. Because this par-
ticular image is a little too blue, we need to give it
more warmth. Adjusting the sliders to give us
more yellow, red and a little green lends this pho-
tograph a more natural hue.

MANAGING PHOTOGRAPHS
digiKam makes an excellent photo library. As
well as the traditional concept of albums, it
introduces tags for photographs by category.
Photographs can have multiple tags, allowing
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Figure 7. The Color Balance Correction Tool

Figure 8. The Original and the Corrected Image

Figure 6. Despeckling an Image Using the Noise
Reduction Tool

Figure 9. The Tag Management View
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you to search for related groups of photo-
graphs easily, irrespective of what album
they are in or what date they were taken.
To create a new Album, right-click on My
Albums in the sidebar of the Album view,
and select New Album. Give your album a
title and a comment, and optionally select a
category for it. The simplest way to import
photographs into your albums is to drag
and drop them from Konqueror. Highlight
the group of photographs you’d like in your
album, and drag them with the mouse into
the digiKam album view window. digiKam
copies the photographs into the album. To
set captions and comments for individual
photos, right-click on the thumbnail of the
photograph, and select Edit Comments and
Tags. You can add new tags from this win-
dow by right-clicking in the Tags pane or by
using the Tag menu. The Tag tab on the
sidebar takes you to a view that shows you
your images grouped by tag and what
album they come from.

PRESENTATION
digiKam has a great tool for exporting your
images to an HTML gallery you can post on
the Web. Any comments you’ve added to
your images are printed below the photo-
graph in the gallery. Select HTML Export
from the Album→Export menu, and select
the albums you’d like to export to the Web.
Click on Look on the iconbar to modify the
title of your Album. Once you’ve finished
customizing the options, Click Ok. By
default, the gallery is created in your home
directory, and it is opened in Konqueror for
you to preview once you’re done. Now you

can upload this folder to your Web space. If
you don’t like the default folder name, you
can rename it to anything you want.

If you’re a GNOME user, don’t despair!

Next month, we’ll take a look at how to
touch up photographs and manage
photo collections with Gthumb
(http://gthumb.sourceforge.net).�
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Figure 10. The Finished Web Gallery

Jes Hall is a UNIX sys-
tems consultant and
KDE developer from
New Zealand. She’s
passionate about help-
ing open-source soft-
ware bring life-chang-
ing information and
tools to those who
would otherwise not
have them.
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In general, we do not print blatantly self-serving
articles from vendors or authors of software, even
if the software is open source. When companies
approach us to write an article for TUX, we set
guidelines as to how the article may read, and we
request that they focus on case studies, not on
“selling” their software. Metadot provided an arti-
cle that does not read like an advertisement, so
we fixed a few spots and published it for the ben-
efit of our readers.—Ed.

CASE STUDIES OF METADOT
Educational institutions—from nursery-school pro-
grams to massive universities—have recognized
the power and economics of an active Web site.
Nearly every school of every size and shape has
built its own Web site. Beyond that, however,
these Web sites vary greatly in terms of usability,
information available and timeliness of informa-
tion posted to the site. This article discusses how
several institutions have taken advantage of open-
source technology to build powerful, yet easy-to-
use and dynamic Web sites.

All school IT administrators face the same
problem. Users constantly request changes,

updates and modifications to a school’s Web site,
and there never is enough time in the day to get
all the requests accomplished. Your site or your
hundreds of sites are constantly outdated and you
would like to automate them.

Although many content management applica-
tions are available today, educational institutions
have long been a proponent of open-source soft-
ware. The two primary reasons for considering
open source are cost and the fact that open-
source software often answers the needs of users
by providing the right features or functionalities.
Let’s review these two reasons.

Educational institutions have been cash-
strapped for as long as I can remember. It seems
there is a chronic funding deficiency for schools in
the US. Therefore, these organizations must care-
fully justify the spending of every single dollar.
Free software is cheaper than non-free software,
yes? Yes, but the cost of software also includes
the total cost of ownership (TCO), which includes
maintenance, support and downtime costs. Open-
source software has somewhat of an okay record
TCO-wise when compared to commercial software
running on commercial operating systems.

The second point for strongly considering
open-source technology for educational institu-
tions relates to the open-source software develop-
ment process: the users of the software dictate
what they want, not a marketing team. Therefore,
all new features are features someone needed and
developed or had developed for them. The direct
result is that open-source software does the job
wonderfully. It often does not offer a soup-to-nuts
solution like enterprise software does, but it
focuses on doing one thing very efficiently.

Let’s review how several different schools are
using open-source content management systems.
Jenna Stone is the Director of Technology for
Massena Central Schools in upstate New York, a
rural district serving approximately 3,000 students.
Like many districts, school officials were having a
hard time communicating with their external audi-
ences—parents and local officials, for example—
because paper and postage costs are high, and
information sent home in backpacks didn’t always
make it home. As a result, they have focused on
their Web site as a means of communication.
Jenna used the Metadot Portal Server to create a
cost-effective intranet/extranet solution (six unique
Web sites that include five buildings and the dis-
trict) that is being used by students, teachers and
school officials.

Content varies across the district’s multiple
sites. The principals of two buildings, for example,
post announcement bulletin data on the site every
day. Weekly spelling lists are posted on another
site and are no longer sent home to parents on
paper. Teachers who have always wanted their
own Web sites can now create and manage their

OOppeenn--SSoouurrccee  MMeettaaddoott  
MMaakkeess  tthhee  GGrraaddee  ffoorr  SScchhoooollss
Metadot provides some case studies where people have 
had success using their Web site management software.

DANIEL GUERMEUR
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own individual sites.
Like all K–12 school systems, Massena

makes every effort to maximize the use of
its limited technology dollars. One strategy
that has been successful for Massena is
using open-source software that is so user-
friendly that content on the site is main-
tained by principals, teachers and building
secretaries. Jenna says it is imperative that
the principals, teachers and/or clerical staff
maintain the content on the site, as the
site is only as good as the content that is
on it. They previously used a more cum-
bersome application, but it was an empty
shell because no one could update it. Now
they can update the content in as little as
five minutes, so they are saving money
because of the product’s low cost as well
as the fact that it’s easy for the IT staff to
maintain (and easy for others to update).
According to Jenna, Metadot’s biggest
advantage is its ease of use. “I don’t care
if the software is free, if it’s not easy to
use, then it’s not going to work for us”,
says Jenna. “With Metadot, you don’t
have a steep learning curve for people
learning to insert content on a site.”

Even schools with sophisticated
infrastructures and healthy IT budgets
have turned to open-source Metadot as
a solution for their portal needs. World-
renowned MIT is a highly decentralized
organization, meaning that each MIT
department is free to select their portal
solution, intranet and project Web site.
Some of them, like MIT’s Civil
Engineering and Environment depart-

ment (CEE), have chosen to use
Metadot for their department Web site
and intranet. The public MIT CEE Web
site is visible on the Internet at
http://cee.mit.edu. MIT’s CEE depart-
ment rolled out Metadot in several
phases, starting with a new look-and-
feel design, information architecture
and content migration. The Metadot
look-and-feel templates are bundled
together into a skin. Skins, which con-
tain images, cascading style sheets
(CSS) and template toolkit files, are very
popular in the Open Source community
because they allow unlimited look-and-
feel creativity (because they separate
look and feel and code logic). The CEE
site is managed by the department’s
communication officer, who does not
have a technical background. In addi-
tion, the department is making space
available on the Web site for students
so that they can take advantage of the
program’s power and flexibility to suit
their own purposes.

Today the CEE site has three main
functions: as the official public-facing
Web sites for the department, to pro-
vide researchers with their own personal
Web site so they can publish informa-
tion and research about their projects
and share their papers, and to provide a
collaboration area for recruiting where
MIT employees can obtain information
and share feedback on prospective can-
didates. In a collaborative area, they
post candidate information, such as
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Figure 1. Massena Page Created with Metadot
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CVs, letters of reference and com-
ments from people who have inter-
acted with the candidate. This highly

dynamic site allows the faculty to
participate actively in the depart-
ment’s hiring process. In the future,

MIT’s CEE department plans to
migrate existing databases that are
not Web-enabled into the Metadot
Portal Server, thus providing a central
point of Web entry to the entire
organization.

The University of Florida’s
Department of Materials Science and
Engineering stands among the best
materials, metallurgy and ceramics
departments in the nation, with cur-
rent research expenditures of approx-
imately $10 million a year from
external contracts and grants. The
department has 31 faculty members,
30 scientists and research scholars,
more than 450 students and 20
technical and support staff. As one
of the top ten research universities in
the country, the university’s profes-
sors are technically savvy. MSE
Director of IT Ed Bailey wanted to
create a Web site template and
empower each professor to create
his or her own site for posting class
and grant information.

Bailey said that he looked at sev-
eral portal solutions, but the ones he
liked were priced prohibitively high
($50,000 per licensed processor). He
ultimately chose Metadot because of
its price, flexibility, strength and the
fact that it is an open-source prod-
uct. Many grant agencies expect
research to be available on a Web
site, and Metadot enables the uni-
versity to fulfill this qualification.

There are currently 19 active
Metadot portals in place at the uni-
versity, and 15 more are in the plan-
ning stages.

These are merely a few examples
of ways that educational institutions
of varied sizes have optimized the
power of open-source software.
Whether the Web sites are being
used internally or externally, it’s
imperative that they are easy to
access and easy to edit so that the
content is never outdated. By invest-
ing in an easy-to-use open-source
content management application, IT
administrators will have more time to
focus on strategic business initiatives
and spend less time updating the
Web site(s). Although the content
management software market is very
crowded, solutions exist that enable
educational institutions to take
advantage of dynamic Web site tech-
nology. These solutions can answer
collaboration and communication
needs while providing content man-
agement tools that are easy to use,
hence providing an instant productiv-
ity boost for those using them.�

Daniel Guermeur is
founder and president
of Metadot
Corporation. He can
be reached at
Daniel@metadot.com.
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Figure 2. CEE Site Created with Metadot
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Audacity is a cross-platform audio editor that provides some of the same abili-
ties as store-bought audio editing programs such as Peak Express. This pro-
gram has more capabilities than merely cutting and copying files; Audacity
also can record from an input source, which goes along with mixing multiple
audio files together. This is the same type of utility that Audio Production
Studios use, although they use a hugely expensive program called Pro Tools.

I downloaded the source and compiled it myself, but most of you should
be able to download the packages. You can use a package manager such as
Kpackage or Synaptic to install Audacity, if it is available for your distribution.
You also can install the packages with apt-get or yum at the command line.
Finally, you can download Audacity as RPM or DEB packages and install them
locally at the command line. For more information on downloading Audacity,
visit http://audacity.sourceforge.net.

GETTING STARTED WITH THE AUDIO FILE
Let’s assume you have installed the program and have it running. In this arti-
cle, we are take an audio file and turn it into an audio preview file. We turn
the stereo audio into mono, normalize the audio, crop it down to 30 sec-
onds and use a fade in/fade out.

The first step is to open an audio file for editing. Go to the Project menu
and select the Import Audio option. This brings up the Open File window.
Here, select the audio file you want to import. Make sure the file that you
are going to import is a WAV file before importing it. And, always make sure
the audio file is stopped before trying to edit it. This means pressing the
giant button with the Square in it to stop the file from playing. You also can
press the spacebar to start/stop playing the audio.

BOUNCING TWO STEREO TRACKS TO ONE MONO TRACK
Now we have the audio file open that we are going to edit. Next, we need
to split the left and right channels into their own separate tracks and then

convert them into mono tracks.
Figure 1 shows the menu to split
the tracks into the left and right
channels. Select the title of the
audio track (on my track it is
labeled “harder”). Once the menu
comes up, select the Split Stereo
Tracks option. You should now
have two separate tracks; you will
use this same menu shown in
Figure 1 again to change the two
tracks to mono. Select the title of
each audio track, and select the
Mono option.

Doing this allows the two tracks
to be mixed together. Next, we mix
the two tracks together into one
single track, which is called bounc-

HHaavviinngg  tthhee  AAuuddaacciittyy  ttoo  MMaanniippuullaattee  SSoouunndd
How to use the cross-platform program Audacity to edit sound files.

JOSHUA BACKFIELD
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Figure 1. Changing the Tracks to Mono

Figure 2. Mixed Audio Tracks
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ing. Select both tracks; you can do this one of
two ways. You can select the audio pane, which is
right under the drop-down menu you used to
change the audio track to mono, and then select
the other track while holding down the Shift key.
Or, you can go to the Edit menu, followed by the
Select submenu, and then select the All option.
This selects all of the audio tracks in the entire
project. Either way works the same for this proj-
ect. You then need to go to the Project menu and
select the Quick Mix option. This should bounce
the two audio tracks into one single audio track. If
done correctly, your audio file should now look
something like the one shown in Figure 2.

NORMALIZATION IS IMPORTANT IN AUDIO
Normalization is the process of adjusting the loud-
ness of an audio track so it is the same throughout
the entire track. We select the new audio track by
going to the Edit menu, then the Select submenu
and then selecting the All option. Now go to the
Effect menu and select the Normalize option. Keep
the two options selected by default, and press the
Ok button to begin the normalization process.
After the normalization has finished, the audio file
should have no large peaks or low valleys. This
allows the audio track to have about the same
loudness throughout. This also keeps the listener
from constantly turning the volume up and down.

CREATING THE CLIP WITH FADE IN/FADE OUT
Next, we cut out about a 30-second portion of
the audio track. With the I cursor selected—this is
the tool in the upper left-hand corner of the pro-
gram that looks like an uppercase I—drag and
select the portion of the song you want to keep.

You can see the length of the portion you are
selecting in the bottom left-hand corner, as

shown in Figure 3.
Select as much or as lit-

tle as you want; in this
example, I am selecting
about 34 seconds of
audio. Now that you have
selected the audio that
you want to keep, go to the Edit menu and select
the Trim option. This also is known as Trim
Outside Selection, which cuts off the audio not
within your current selection.

Next, we place a fade in/fade out on the audio
file. Take the I cursor and select only the begin-
ning of the track, which will have the fade in. As
shown in Figure 4, you can see that only the part
of the clip that I want to have the fade in is
selected. After selecting the portion of the clip
where you want the fade in, go to the Effect
menu and select the Fade In option to create the
fade in for the track. Do the same for the fade
out; except, instead of selecting a portion at the
beginning of the clip, select a portion at the end
of the clip. Then go to the Effect menu and select
the Fade Out option.

SAVING THE FILE FOR ALL TO SEE (AND HEAR)
We now have a 30-second mono clip, which has a
nice fade in/fade out. Now, we need to get it out
there for our friends to hear. To do this, go to the
File menu and select the Save Project As option so
that you can return to your project whenever you
want. However, not everyone in the world can
open an Audacity Project file (.aup file), so now go
ahead and export the file. Because we have only a
little bit to export, go to the Edit menu, then the
Select submenu, and finally, select the All option to
select all of the audio in the track. Then go back to
the File menu, and select the Export Selection As

WAV option, which saves your project as a .wav
file that everyone should be able to listen to.

SO WHERE DO I GO FROM HERE?
You now can take your new WAV file and change it
to an MP3, AVI, MPEG or AAC file using a program
designed specifically for changing audio file formats.
I have shown you the basics of the program
Audacity; it is up to you to use it to its full potential.
For most people, this program is considered “cool”;
however, for some new audio recording studios
looking for a cheap alternative to Windows XP and
Pro Tools, this program may be the perfect choice,
especially because of its cross-platform abilities.�

Joshua Backfield is a 22-year-old student at Southern Illinois
University Carbondale. He is currently doing his internship at
Dupage County Convalescent Center, where he is helping peo-
ple learn the benefits of using Linux.
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Figure 3. Length of Clip Selection

Figure 4. Fade In Selection
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When novice artists think of creating artwork,
they usually think of programs like The GIMP,
Photogenics or some other program with features
similar to Adobe’s Photoshop. Sometimes these
programs are the appropriate tools. Sometimes
they aren’t. Many people end up working harder
than they have to because they are trying to use a
program like GIMP to do things that are more
appropriate for a drawing tool.

If you have ever used CorelDRAW, you have a
good idea of what a drawing program does.
Inkscape is something like CorelDRAW. If you
haven’t used CorelDRAW, here’s an example of
where a drawing tool like Inkscape would come in
handy. Suppose you want to draw a cartoon charac-
ter without a “sketchy” look to it. You want the
outline of the character to be composed of solid
lines, not lines that look like pencil sketches. And,
you want the lines to be connected perfectly in all
the right places so that you can color-fill different
parts of your character without the colors leaking
through a hole in your outline to another part of
your character. The problem is that you don’t have
the skill to draw the perfect solid-line outline of a
cartoon character using the freehand drawing fea-
ture in GIMP. Worse, if you draw the character in
GIMP and then decide that you have to enlarge it or
shrink it, the outline becomes distorted. It may even
develop “holes” through which color fills bleed.

Here’s what you would like to do, instead.

You’d like to draw the solid lines of your cartoon
character with all of its features (shirt, hands and
so on) the best you can, and then adjust the
shape and position of these lines until you’ve got
it just right. If you discover that you’ve drawn the
character too big or too small, you want to be
able to change the size of the cartoon character
outline without distorting your hard work.

This is the sort of thing Inkscape does extremely
well. In this case, you might want to start with
Inkscape and finish your cartoon character in GIMP. It
doesn’t matter. The point is that Inkscape does some
things better than other programs, and you want to
use the best tools for the job whenever possible.

VECTOR GRAPHICS
Inkscape makes the drawing task just discussed
possible because it is a vector editor. You may have
no idea what vector graphics are, but you probably
have heard the term SVG by now. More and more
programs, Linux distributions and devices are boast-
ing support for SVG (Scalable Vector Graphics).

What’s the buzz? What is a vector anyway, and
how does it make graphics scalable in such a way
that all other graphics are not?

Let’s start with a simple thought experiment.
Imagine that you have before you a simple
image—say, a black disk on white background—
and you need to describe it to your friend over
the phone, so that she can reproduce it as exactly

as possible. How would you go about that?
Well, you’d probably say something like, “draw a

solid disk, colored black, diameter...let me
check...eight millimeters precisely, and its center is
one centimeter from the top and from the left.”
That description (Figure 1) indeed gives a complete
representation of the image; there’s nothing in it that
was not mentioned. Such a vector representation of
an image is short, easy to understand (at least for
humans) and so natural that you may not realize
that different approaches to this simple task exist.

The bitmap of the same image (Figure 2) is what
a computer would create based on this blueprint.

Programs like GIMP let you enlarge the disk,

IInnttrroodduuccttiioonn  ttoo  IInnkkssccaappee
Why you may want to use Inkscape and how to get started.

DMITRY KIRSANOV

Figure 1. The Perfect Disk Described

Figure 2. A Bitmap Version of the Disk
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but the end result is less perfect than the original.
You can improve the end result by using anti-alias-
ing, but even an anti-aliased version can never be
as good as the vector-based original disk.

VECTOR SCALABILITY
In the vector blueprint of the black disk image, you
can easily replace millimeters with meters and
draw the perfectly round disk the size of your
backyard with no loss of quality. When you have a
bitmap, however, scaling it up inevitably produces
jaggies and that annoying pixelated look—because
you are, in fact, scaling the pixels, not the image.

The point is that if you stick with vector graphics
for your circle, you don’t have to redefine the size
and start from scratch to get a perfect circle. You can
expand the original or shrink it without losing any of
the fidelity of the original circle. You do not need to
do any anti-aliasing or perform any other tricks.
That’s why scalable vector graphics are called scala-
ble. They scale up or down without distortion.

If you still want to have a bitmap image when
you’re done, it’s easy to convert an SVG image to
a bitmap. This is called rasterization. Although it is
easy to go from vector to bitmap, it’s not easy to
go from bitmap to vector.

In a way, the difference between vector and
bitmap is similar to that between the source code
and a compiled binary of a program. Source is for
humans; binary is for computers. Source is the “idea”
of the program; binary is a specific “implementa-
tion”. The entire Open Source movement grows from
the premise that you can make this world a better
place by sharing ideas, not implementations. Can we
apply the same principle to sharing images too?

WHY SVG?
The idea of vector representation of images is not

new. In fact, it may be even older than the concept
of a bitmap. However, until recently, vectors were
used mostly in professional design workflow,
whereas the images on the Web and on typical end
users’ desktops were almost exclusively bitmaps.

One reason for that was the lack of a single,
universally applicable and universally accepted, vec-
tor graphics standard. PostScript, PDF and Flash are
all vector formats, but they are specialized and
therefore limited in various ways. Here’s where
SVG’s promise lies: a modern XML-based lan-
guage, created by the W3C, can certainly give a
huge impetus to the use of vector graphics every-
where. SVG (http://www.w3.org/Graphics/SVG) is a
powerful (some would say overpowered) language
with provisions not only for geometric shapes but
lots of other things—gradients, filters (including
blur), pattern fills, fonts and even animation.

Of course, SVG can’t replace bitmaps outright,
if only because not all graphics can be represented
as vectors. This works fine for disks and other geo-
metric shapes, but what about photographs, for
example? Well, for one thing, a powerful modern
vector language such as SVG can do amazingly
photorealistic graphics. And for another, SVG can
embed bitmaps into its vector image, treating
them just like any other object (for example, you
can overlay an embedded bitmap with vector cap-
tions and callouts, which is what I did in Figure 3).

But perhaps the more serious obstacle in the
way of SVG is users’ inertia. As mentioned previ-
ously, many people tend to think in bitmap by
default, even when vector makes much more
sense. Say “computer graphics”, and more often
than not you’ll hear “Photoshop” or “GIMP” in
response. Yet among the images that a typical
user deals with daily, perhaps only digital photos
require strictly bitmap processing. All the rest—

drawings, logos and Web graphics, diagrams and
flowcharts, headings and clip art, postcards and
wedding invitations, even random scribbles—is
much easier and more natural to do in vector.

It’s difficult, however, to evangelize about the vec-
tor bliss when the only decent vector graphics tools
(such as Illustrator, CorelDRAW and Xara X) are limit-
ed to Windows and/or Mac, use proprietary formats
and are quite expensive. Fortunately, this has
changed recently with the advent of Inkscape
(http://www.inkscape.org)—a free multiplatform vec-
tor editor with SVG as its native format. In its latest
version (0.42 at the time of this writing), Inkscape
has become seriously powerful and very usable.

INKSCAPE
The interface of Inkscape (Figure 3) is easy for new-
bies. The big bright buttons in the vertical toolbar
on the left are inviting—and, more importantly,
they do exactly what you think they do. Click on
the blue rectangle, then draw on the canvas—you
get blue rectangles. Click on the red ellipse and
drag—you get red circles and ellipses. Fun!

But the real fun of vector graphics is not
drawing; it’s “editing”.

Create some rectangles and disks as described
above. Click on the topmost button (with an arrow)
on the vertical toolbar—it’s called the Selector
tool—and then click on any of the objects (rectan-
gles or ellipses) you just created. Immediately that
object becomes selected—you see it framed in a
dashed box, and eight handles appear around it. A
selection can contain any number of objects; use
Shift-click or drag objects around with the Selector
tool and watch the status bar at the bottom of the
window, which tells you how many objects and of
what kind you have in selection.

Think of what you’ve done. If you’ve ever had
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some experience with bitmap editors such as
Photoshop, you may know how difficult it often is
to separate something (for example, a human sil-
houette) from the background, and how poor the
results can be. With vectors, all you need to do (in

most cases) is a single click. Objects in a vector
image are never merged or flattened; the drawing
always remembers what it consists of. It’s like put-
ting each single stroke and shape onto a layer of its
own, except that it’s done automatically for you.

So what can you do to a selected object? A lot.
You easily can drag it around to wherever you like,
and you can stretch or scale it to any size by drag-
ging the handles (Figure 4).

If you click the object again, the handles
change and you can rotate the object (Figure 5).
You can also easily skew the object.

Don’t like the color? Use the Fill and Stroke dialog
to change it. You can bring up this dialog by right-
clicking on the object and selecting Fill and Stroke
from the pop-up menu. You should see a dialog like
the one in Figure 6. There are several ways to
change the color. You can play with the sliders in the
default tab, or try some of the other tabbed tools.

The Fill and Stroke dialog also lets you change
the opacity of the selected object. You can change
the stacking order (or z-order as it’s usually called)
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Figure 3. The Inkscape Interface

Figure 4. Stretch your objects easily.

Figure 5. Rotating an Object
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of objects as well; use the Raise/Lower commands in the
Object menu. You can combine several objects into a
group—a single composite object. Or, simply press the
delete key and the objects you have selected are no more.

DRAWING WITH INKSCAPE
Of course, you’re not limited to geometric figures. You
also can do freehand drawing (Figure 7).

Here, too, every stroke is an object in its own right,
selectable and modifiable separately from others. For
example, you can use the node tool (the tooltip says
“Edit path nodes or control handles”), which is the
icon right below the arrow selection tool. You also can
press F2. This tool lets you reshape a line you have
drawn. Simply grab (click on) one of the nodes that

appears, and pull
it in any direction
to modify the line
(Figure 8).

A very nifty
Inkscape tool is
the Calligraphic
pen, which is very
convenient for
making draw-
ings—either tech-
nical or artistic.
You can create
sketches where
every stroke is an
object (Figure 9).
There are 1,116
individual lines in
this sketch.

This article
should give you a
general idea of
what Inkscape is
for and what it
can do. I hope you
will take it from
here and explore
the program on
your own.�
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Figure 7. The Beginning of a Face
Figure 8. You can adjust lines without
erasing or starting over.

Figure 9. An Artistic Sketch with the
Calligraphic Pen

Figure 6. Fill and Stroke Dialog

Dmitry Kirsanov (http://www.kirsanov.com) is
an independent author, designer, artist and
consultant in the areas of XML, XSLT and SVG.
His most recent book is XSLT 2.0 Web
Development (ISBN 0131406353).
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In a perfect world, one size would fit all, no one
would ever tell you “your mileage may vary” and
computer users the world over would be able to
work in harmony using the same software tools. This,
however, is not that world. In this world, you can put
200 e-mail users in the same room, and no two of
them would go about their task in the same way.

So why should folks e-mailing each other be con-
strained by their software? Enter Thunderbird, an e-
mail client that was designed to be extended with lit-
tle add-ons that provide additional features to the
software. This article explores Thunderbird’s open-
ended architecture and takes a quick look at some of
the many extensions that let you modify Thunderbird
to work the way you like to work. Even if you
already use and love Thunderbird for other reasons
(such as its Bayesian spam filtering, which continually
improves its ability to recognize spam), Thunderbird’s
extensions will convince you that a ride on the wings
of the T-bird is a very comfortable ride indeed.

Thunderbird extensions provide many features,
from adding new keyboard shortcuts, to tricks for
replying to and forwarding e-mail and other, more
esoteric functions. Curious? Plunge right in; no need
to be shy. Adding and using new extensions is easy,
and that’s half their attraction. From the Tools pull-
down menu, select Extensions. A window opens
showing a list of currently installed plugins, if any,
each with an icon. At the bottom, the install, unin-
stall and update buttons let you choose which plug-

ins to use, and the options button allows you to
configure the extension currently highlighted under
the cursor. The options button is enabled only if the
extension you currently have selected has any
options to configure—some extensions do not.

HOW TO GET EXTENSIONS
If you don’t have any extensions, click the Get
more extensions link at the lower right of the
window. Then, Thunderbird opens up your
default Web browser and goes to the Web site
http://addons.mozilla.org, where you can browse
through available extensions. Of course, you can just
as easily navigate your Web browser to that Web
site yourself and start browsing. If, for some reason,
the Get more extensions link in the extensions dia-
log does not start a browser, then do just that.

Once you get to the Thunderbird extensions
portion of the site, you’ll quickly come to appreci-
ate the diversity of extensions available to you.

Adding an extension to Thunderbird is as easy
as downloading a small file to your computer and
then installing that file using the Extensions dialog.
The file you download will have the extension .xpi.

Select an extension you like from your browser.
If you pick one from the most popular list, you
will be redirected to the download page X or Y. If
you are browsing through the extensions by cate-
gory or “all”, you will need to click on More Info
to get to the download page.

You should see an Install Now package. Right-
click on that package and select Save Link As...
from the pop-up menu, and then choose a fold-
er/directory where you want to save this extension.
Save it anywhere you like—your desktop would be
fine. Once you’ve downloaded the .xpi file, go
back to the Extensions dialog you opened in
Thunderbird and click the Install button. Navigate
to where you’ve saved the .xpi file, then click OK.
Thunderbird may or may not warn you “A Web
site is requesting permission to install the following
item (unsigned) from {URL}. Malicious software can
damage your computer or violate your privacy.”

If you believe you trust the creator of the
extension, proceed. Click the Install now button
and you can rock and roll. Some extensions func-
tion immediately, while others ask you to restart
Thunderbird so they can be activated.

So what can you do with extensions? Lots.
Odds are, someone else has already thought of a
trick you have been wishing all this time you could
do. Let’s look at a few extensions that make e-
mail a little easier to deal with.

ATTACHMENT EXTRACTOR 0.4, BY ANDREW
WILLIAMSON
This little extension is one of my favorites. It
allows you to extract attachments from selected
messages or whole folders. It can save over exist-
ing files, rename a file if it already exists or even

EExxtteennddiinngg  TThhuunnddeerrbbiirrdd::  tthhee  BBeesstt  ooff  AAllll  WWoorrllddss
Randall Wood explains how to extend Thunderbird to suit your wants and needs and provides a look at some of the extensions available.

RANDALL WOOD
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ask you each time. You can opt to have it delete
messages, mark them “read” or simply do noth-
ing after it extracts the attachments.

You will need to restart Thunderbird after you
install this one. Next, open up the Thunderbird
Extensions dialog, select this extension and click
on the options button to configure the extension.

Now you will find Extract Attachment options
in your Tools menu. You also can right-click on
any message and invoke this extension from the
pop-up menu.

TB QUICKMOVE EXTENSION, BY FRANK DILECCE
This extension is no longer available on the Mozilla
Web site (the last time we looked), but it’s worth
finding with Google. It’s available it at AusDilecce
Extensions (http://www.supportware.net/mozilla)
and several other Web sites. It lets you assign
folders to the key combinations Ctrl-1 through

Ctrl-0. When you have
selected an e-mail mes-
sage, pressing one of
those key combinations
moves the message to
the folder associated
with that key combina-
tion. The right-click
context menu also
shows QM message to
... folder as an option. Fast and easy! To configure
the key combinations, select the extension from
the Extensions menu and either right-click and
select Preferences from the pop-up menu or click
the Options button.

STACKED VIEW EXTENSION, BY AARON ONEAL
Traditionally, e-mail programs have one pane for
the folder list, one for the index of messages and

one pane for the message itself. This
extension reorganizes the layout of
these three panels so that the folder list
and message index sit at the left-hand
side of your window, one over the
other, and the bulk of your window can
be used for reading the message. This
isn’t quite the same as the three paral-
lel-column layout that Thunderbird pro-
vides natively, and in my opinion, it is a
much more efficient use of your valu-
able screen real estate.

Install this extension, restart
Thunderbird, and then you can select
the stacked view by clicking
View→Layout→Stacked View from the
main menu. Even if you like this view,
you’ll probably want to adjust the size
of the panes to suit your tastes.

DISPLAY MAIL USER AGENT EXTENSION 1.0.1, BY
CHRISTIAN WEISKE
Finally, a little something for the Thunderbird
advocates out there. This extension adds a little
icon to the headers of your e-mail messages to
show which program was used to write the
message, such as Outlook, LotusNotes or Eudora
(this information is encoded into almost every e-
mail sent, in case you didn’t know). What a
great way to identify which of your friends are
still suffering with less-flexible software. Help
spread the word!

Now that you know where to find extensions
and how to install them, have fun shopping!
Thunderbird currently boasts more than one hun-
dred extensions that will allow you to shape the
program to fit your needs. And once you’ve con-
figured Thunderbird to work just the way you like
it, you’ll find you have a hard time going back to
any other program. Happy mailing!�
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Figure 1. Right-click on the extension icon to configure the
extension to your liking.

Figure 2. Display Mail User Agent extension shows this message came from
a Eudora user.

An engineer and writer by training,
Randall Wood has been using Linux and
open-source software since 2000. He
and his wife currently reside in
Washington, DC. His Web site is at
http://www.therandymon.com.
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Thanks to Vinay Khaitan’s Google Suggest Toolbar
for Konqueror, Konqueror devotees now have
access to many of the same features Internet
Explorer and Mozilla Firefox users enjoy with the
official Google Toolbar. A free, open-source exten-
sion, the Google Suggest Toolbar for Konqueror
interacts with Google’s services, allowing you to
search the Web quickly, translate Web pages,
highlight keywords on a page, look up terms in a
dictionary or an encyclopedia without leaving the
current page, and much more.

INSTALLATION AND CONFIGURATION
The Google Suggest Toolbar is relatively young
software (version 0.6 at the time of this writing),
and ready-to-install packages are not yet available
for many of the major Linux distributions. Your
mileage may vary. Some people have had prob-
lems getting the plugin to work properly. A new
version has been released since I tested it. It may
resolve those problems.

You’ll have to venture into Geek territory to
install Googlebar. This means you need to open a
command shell, log in as root, and compile
Googlebar from the source code. Don’t worry—
it’s only six little commands. If you’re too timid to
do this, ask a geek friend to help or simply wait
until a package is available for your distribution. If
you are feeling cocky and brave, you’ll be sur-
prised at how easy it is to compile and install this

program. As I said, it’s only six little commands.
There is only one catch. You need to have

development tools and some KDE development
packages on your system for this to work. See the
sidebar “What You Need” for more information.

Assuming you have installed all the tools and
libraries you need, here is how to install Googlebar.
First, download the tarball from SourceForge.net at
http://sourceforge.net/projects/googlebar (or, more
specifically, follow the Download road until you
land on SourceForge’s download mirrors page,
and select the appropriate mirror for your state,
country or continent). Your browser will give you
the option to open the file or save it. Save it to
your Home directory.

Next, open a terminal program, such as KDE’s
Konsole, which is typically found in the System appli-
cations submenu, and type the following command:

$ tar -xjf googlebar-0.6.tar.bz2

This unpacks the various source code files in
the tarball you just downloaded and moves them
into their own subdirectory, googlebar.

Next, switch into that directory by typing:

$  cd googlebar

The next three steps are fairly common to all
open-source programs for Linux: configuration,

compilation and installation. On a typical system,
the following commands, without any alteration,
should just work. If they do not, consult the
Google Suggest Toolbar documentation (that is,
the README file) for more help. Take note: a lot of
information will fly by when you run these! Ignore

GGooooggllee  SSuuggggeesstt  TToooollbbaarr  ffoorr  KKoonnqquueerroorr
Add Google Options to your KDE browser with Googlebar.

WILLIAM KENDRICK AND MELISSA HARDENBROOK

WHAT YOU NEED

You may need to install additional packages
before you can install this extension. If you
do not already have them installed, you will
need some common development packages,
such as g++, the C++ compiler. You also may
need development packages specific to X11,
such as x-dev or another similar name, and
development packages for KDE, such as
libkonq4-dev. Package names may vary from
distribution to distribution. Many distribu-
tions include meta-packages for development
and KDE development. A meta-package is just
a simple way to download all the packages
you’ll need by installing one package name. If
your distribution groups packages into these
types of meta-packages, it should be obvious
what you need to install by the names of the
packages (and descriptions, depending on the
installer you use, whether you’re using the
Fedora installer, Synaptic, Kpackage and so on).
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this information unless you hit a snag, in which
case it might be useful for trouble-shooting.

Type:

$  ./configure

Then type:

$  make

Next, you’ll need to switch from a normal user
to your alter-ego, the superuser (a.k.a. root), who
has complete control over the computer. Type:

$  su

When prompted, enter your system’s root pass-
word.

Finally, type:

#  make install

This should automagically install the extension
where Konqueror can find it.

At this point, assuming everything went
smoothly, you can switch back to your old, less-
super self (type exit, press Ctrl-D or close the ter-
minal window) and launch Konqueror.

To activate the Google Suggest Toolbar, head to
Konqueror’s Settings menu and choose Configure
Extensions... (Figure 1). You may need to quit and
restart Konqueror. If you already have a Search Bar

Plugin installed, you
may want to uncheck
that box. You won’t
really need it after you
start using Googlebar.

FEATURES AND USE
After you’ve installed
the extension, you’ll
notice three new addi-
tions to your Konqueror
toolbar: two drop-down
buttons and a text entry
field (Figure 1).

Access the exten-
sion’s options window
through the new G-
shaped drop-down but-
ton, which also houses a
number of quick links to
various Google service
home pages (Figure 2).

The new I-shaped drop-down button teaches
Konqueror a few neat tricks, like fetching Google’s
cached pages so you can compare what’s on a page
now with what was on a page before (Figure 3).

Also with the I-button, Google will point
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Figure 1. Google Suggest Toolbar Additions to Konqueror

Figure 2. The Google Suggest Toolbar’s Options
Window

Figure 3. The Google Suggest Toolbar’s Page 
Info Button
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Konqueror to “similar” pages (Figure 4), back-trace the links and show you
all the roads leading to the page, or even translate the page into English
with Google’s translation tool.

Use the text entry field to search the Web (and elsewhere—more on this
later) for keywords. As you type, a menu drops down, offering you a real-
time generated list of common terms you might be looking for (Figure 5).

For example, type “health”, and the menu offers suggestions like “health
care” and “healthy eating”. If you go on to type “insurance”, you’ll see
phrases like “health insurance quotes”, “health insurance providers” and
“health insurance companies”. You can quickly choose any one of these, or
simply ignore all the suggestions and continue typing.

Once you begin typing, you’ll immediately notice a new toolbar appear.
This is the actual Google Toolbar for Konqueror.

Click one of five buttons on the far left of the Google Toolbar to search
the entire Web quickly, the current Web site, Google Groups discussions or
other Google search engines. There’s even a four-leafed clover button, for
when you’re feeling lucky.

You’ll also notice that each word you typed in the text entry form is now
a button on the Toolbar. Click on one, and you’ll see each acts exactly like
the browser’s Find function.

The green and yellow highlighter buttons are nifty little helpers. Click the yel-
low highlighter button to highlight all your keywords, everywhere they appear
on the Web page (Figure 6). Select a word or phrase with the mouse, and then
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Figure 4. Looking at a List of Related Sites

Figure 6. Highlighting Keywords on a Page

Figure 5. As you type, suggested keywords, as well as a new toolbar, appear.
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click the green highlighter button to search
the Web for that word or phrase (yes, this
replaces the current keywords, if any).

Click and hold the magnifying-glass
button next to the new text entry field to
access even more Google search engines:
images, news headlines, products you can
buy on-line (Froogle) and off-line (Catalog),
stock quotes and more (Figure 7).

Along with these obvious additions to
Konqueror, this extension also adds three
new items to the context menu that
appears when you right-click in the
Konqueror window. Select a word or phrase
with the mouse pointer, and then right-click
to access these new features. Unsurprisingly,
you’ll be given the option to search the Web
for the selected term with Google, much as if you’d clicked the green highlighter
button. Additionally, you can request that Konqueror display a dictionary definition or
an encyclopedia entry for the selected word or phrase (Figure 8).

The dictionary and encyclopedia entries appear in a small pop-up window,
rather than forcing you on a browsing detour and re-routing you to a new page
or cluttering your screen with a new browser window (Figure 9).

Download the Google Suggest Toolbar for Konqueror today, and see for
yourself how one extension adds valuable functionality to an already fully-loaded
Web browser. It’s worth the journey into command-line country.�
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Figure 7. Other Search Options

Figure 8. The Google Suggest extension adds some useful items to the
right-click menu.

Figure 9. Viewing an Encyclopedia
Clip for a Term

THE FIREFOX WAY
If you’re a Firefox fan, be sure to check out the official Google Toolbar for
Firefox: http://toolbar.google.com/firefox. Or, check out the Open Source
Googlebar: http://googlebar.mozdev.org.

William Kendrick is a
KDE addict, Linux
evangelist and works
as a cell phone video
game programmer in
Palo Alto, California.

Melissa Hardenbrook is a
night owl, a freelance writer, a
sociolinguist living in a compu-
tational linguist’s world and
Mrs William Kendrick, among
other things.
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In this brand new series, we’ll explore lightweight
desktops as an alternative to KDE and GNOME.
The benefits of using a lightweight desktop are
many, but they are especially good for users of
slower machines, where large desktops will be
clunky and not very usable. Lightweight desktops
can be ideal for some laptops too, especially older
models with processors that aren’t state of the art
and in cases where the installed memory is some-
what lacking (256MB of RAM, for example).

Regardless of the kind of computer you are
using, a lightweight desktop brings benefits in
speed, resources and loading times. It clears out
some of the on-screen bulk that can sometimes
feel in the way with GNOME and KDE. You even
can mix and match different desktop utilities such
as file managers, system monitors and program
launchers to experiment with different styles of
desktops and customize it to your tastes.

Sounds pretty good, right? Is there a catch?
Well, yes. By using a trimmed-down desktop, you
may miss out on many features included in the
bigger desktops if you’ve grown accustomed to
using them. You also lose a degree of user-friend-
liness, eye candy and customization in the
process. But don’t let this put you off. For many
people, the features in bigger desktops are overkill
and get in the way by slowing down the system.

There could be a desktop out there that’s per-
fect for you, and we’d like to explore a few of

them. Today, we explore IceWM.
IceWM has a familiar feel for Windows

users without sacrificing features unique
to Linux, such as multiple virtual desktops.
IceWM also has its own unique style.
There are a decent number of configura-
tion tools, and IceWM is in many ways
interoperable with other desktops, like
GNOME. All in all, IceWM is very cus-
tomizable and fairly lightweight. It has a
well thought-out interface and a lot of
look-and-feel themes available.

FEATURES
Let’s look around the basic desktop. Keep
in mind that what you see when you first
start IceWM may be quite different than
what someone with another Linux distri-
bution sees. Each distribution sets a
default theme for IceWM, and that default theme
is what determines what IceWM looks like when
you start it the first time. See Figure 1 for a possi-
ble default look and feel.

Generally, you will see a taskbar at the bottom
of the screen. This taskbar is rather like that of
Windows or KDE. At the bottom right are some
nifty features—from right to left: a hide button to
clear the screen when the bar is in the way, a
clock with the date and the time, and three
meters that measure your CPU usage, your net-

work activity and your Internet throughput.
On the bottom left (from left to right) is the

usual menu button (or Start button in Windows),
a button for minimizing all windows and a KDE-
like windows list. This lists all of your open win-
dows on all desktops. You can see buttons for
switching between four virtual desktops. This
should make KDE users feel right at home and
should speed up desktop productivity. There is a
keyboard shortcut to make it easier to switch
between desktops: press the key combination
Ctrl-Alt-left arrow to move to the previous virtual
desktop, and Ctrl-Alt-right arrow to move to the

TThhee  WWoorrlldd  BBeeyyoonndd  KKDDEE  aanndd  GGNNOOMMEE
This is the first in a series of articles exploring how to mix and match components to get functional lightweight desktops.

JOHN KNIGHT

Figure 1. A Default IceWM Theme with My Own
Custom Background
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next virtual desktop.
IceWM has some downsides, however. IceWM

lacks desktop icons and a file manager to go with
them. When running multimedia applications like
Xine or MPlayer, you may often run into problems
going to full screen (like a taskbar that stays in
view or a window with a forced border). There are
ways to hide the taskbar, but this still will be an
annoyance for those who use these applications
often throughout the day. Regarding desktop
icons, most minimalist desktops don’t include icons
anyway, so we’ll show you how to add them later.

ICEWM PREFERENCE MANAGERS
There happens to be a number of preference
managers for IceWM, mainly IcePref, IcePref2 and
IceWM Control Panel. These packages are gener-
ally available for almost all distributions. Use your
favorite package manager to hunt them down
and install them.

A quick look around these preference man-
agers will really change your views on IceWM.
They greatly expand what you are able to do with
the desktop. You can turn on/off the CPU/net-
work monitors, add or change the desktop back-
ground, auto-hide the taskbar, change fonts or
themes, assign mouse-button actions—the list
goes on. Any of the three significantly add to the
desktop, but some are better or easier to install
than others, so we look at each one by one.

ICEPREF
IcePref is the original preference manager and still
does a decent job. Of all three managers, this was
the only one I could get working on my PC—even
after hours of experimentation (I had to use anoth-
er distro to get the other two working). IcePref is a
lot more minimalist than the others and not so

feature-laden; the basic options are there, but the
experimental options, like sound events, are not.
It’s well worth trying the other two first, but if they
don’t work, IcePref is still pretty decent.

ICEPREF2
IcePref2 sits in the middle: the second easiest to
install, the second-most featured. IcePref2 is a
remake on the original, cleaning up the base and
re-organizing things. It adds a few extra features,
like the ability to import your KDE menu. It reworks
some of the older features to make them more
usable. If you look in the tools menu, you will find
an option to run some external programs, provided
you have them installed. There is the ability to

make your own themes, edit the menu, design
sounds schemes and run the control panel (the
next manager). Of all three, IcePref2 is probably the
best to have, provided you can get it installed. See
Figure 2 for a sample of what IcePref2 looks like.

ICEWM CONTROL PANEL
This is the hardest to install and the most fully fea-
tured. It requires running a script to install the
package, but it doesn’t work on all systems. It
relies on a number of scripts and packages that
you may not have installed and that may not be
available for your distribution.

IceWM Control Panel acts more like a system
manager than the others, and invokes common

system configuration
utilities, provided you
have them installed.
The general IcePref
options are available,
but this focuses more
on things like printer,
PCMCIA, screensaver
and disk configura-
tion. It is definitely a
useful tool but is more
of a complement to
IcePref2 than a
replacement for it. See
Figure 3 for a look at
the control panel.

When changing
the desktop back-
ground, you will
probably find that
nothing happens;
fire up a terminal
and enter the com-
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Figure 2. IcePref2 Flexing Its Muscles
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mand icewmbg. IceWM now starts up with the
new background every time (or just restart IceWM
if this doesn’t work). A number of the features
included with IcePref2 and IceWM Control
Panel—like sound events—work only with the
experimental version of IceWM, so if these are
important to you, choose IceWM Experimental in
your Session menu.

ADDING A DESKTOP FILE MANAGER
Unfortunately, IceWM doesn’t come with a desk-
top file manager with icons on the screen, which
can be a pain for a lot of users. It is very common
for lightweight desktops not to have desktop
icons though, as it helps cut down on loading

times and your PC’s
resources. Fortunately,
desktop icons can be
added to almost any
desktop, no matter
how minimalist it may
be. We’ll be looking at
the three choices for
adding file managers:
Nautilus, Konqueror
and DFM.

NAUTILUS
Definitely the heavier
option but fully fea-
tured; GNOME users
will be right at home,
and both GNOME and
KDE users will probably
have its existing desk-
top icons. This is what
Libranet uses for their
custom desktop—

IceWM combined with Nautilus. This combination
makes a very strong environment without having
to go to the more bulky GNOME. Even without all
the bulk of GNOME, Nautilus is not a lightweight
file manager, so there is a definite performance
cost in using Nautilus over something like 
DFM. This solution is not recommended for
slower machines.

KDESKTOP
Obviously, the desktop manager from KDE will
make KDE users most comfortable. Kdesktop is an
extremely rich desktop that automatically uses the
Konqueror file manager (and it automatically uses
your KDE-defined desktop background).

Konqueror has features out the wazoo. It also
consumes a lot of resources to support those fea-
tures, so it is not a lightweight choice. This solu-
tion is not recommended for slower machines.

DFM—DESKTOP FILE MANAGER
DFM is an older project designed to be familiar to
OS/2 users. The interface is still fairly user-friendly
and shouldn’t be difficult for new users or
Windows users to learn. DFM is much more light-
weight than Nautilus and is therefore a much bet-
ter choice for people with slow machines or
machines with little RAM installed.

CREATING AND EDITING YOUR STARTUP FILE
You’ll probably need to create your own startup
file to launch your favorite desktop file manager.
The startup file is a useful tool in IceWM, as it
allows you to add on external programs so that
you can customize your desktop. The sky is the
limit as to what you want to do with the startup
file in order to customize your desktop. You can
start your favorite application automatically, add
desktop icons, or create a strange desktop hybrid
(like adding KDE’s Kicker program). You can add
almost any program you like, just make sure you
press Enter to add a new line after each one.
Remember also that every program you add con-
sumes resources. You may reach the point where
your custom desktop is just as resource-hungry as
KDE or GNOME.

It can be a little tricky to create a startup file
because it is in a hidden directory. Navigating hid-
den directories can be complicated in itself, espe-
cially if you’ve never done it before. Therefore, we
cover the steps to create the startup file with two
popular file managers, Nautilus and Konqueror.
Doing this takes four steps: navigating to the
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directory, creating the file, editing it and flagging
it as executable. Nautilus is the more difficult of
the two, so we tackle it first.

NAUTILUS
If you have Nautilus in your IceWM menu, it prob-
ably is under the Gnome→Home Folder. If you
don’t have Nautilus in your menu, open a terminal
and enter the command nautilus --no-desktop.

Once in Nautilus, click on View→Show hidden
files. You should now see a bunch of new directo-
ries that start with a full-stop; in this case, double-
click on .icewm. Now in a blank space, right-click
and choose Create Document→Empty File.
Rename the file to startup and right-click on it,
then choose Open with Other Application and
enter gedit in the new dialog box (or if you pre-
fer using another editor, such as nedit or gvim,
enter that command instead).

The editor should now appear. Enter nautilus
--no-desktop in this file, save and exit. This starts
up Nautilus, which has a boat load of features,
but it won’t show pretty icons in the folders or
put icons on your desktop.

If you want to see pretty icons in the folders or
on the desktop, you need to enter two lines in
your startup file, as follows. To start only the file
manager, use these two lines (don’t forget the
ampersand for the first command):

gnome-settings-daemon &
nautilus --no-desktop

To get the full-blown desktop with the correct
icons, enter these two lines:

gnome-settings-daemon &
nautilus -n

If this doesn’t work for you, your distribution
may have placed the gnome-settings-daemon pro-
gram somewhere your distribution can’t find by
default. One of the most likely alternative loca-
tions is /usr/libexec, so try this instead:

/usr/libexec/gnome-settings-daemon &
nautilus -n

(Or, enter nautilus --no-desktop on the second
line, according to your preference.)

Now right-click on startup, choose Properties,
go to the Permissions tab and check the Execute
box in the Owner section. After all that, startup

should now be ready to go. Restart IceWM, and
Nautilus should start automatically. See Figure 4
for an example of how your system should look.

KONQUEROR
The Konqueror file manager is a lot easier to deal
with. Konqueror probably is under KDE→Home
Folder if you have one in your IceWM menu. 
If not, simply open up a terminal window, type
konqueror and press Enter.

Click on View→Show Hidden Files and make
your way to the .icewm directory. Once inside the
.icewm directory, right-click on an empty space and
choose Create New→File→Text File. Click on the

file to edit it, or if it
opens inside the win-
dow, right-click on it
and open it with an
editor of your choice.
Type the command
kdesktop, press Enter,
and then save and exit
the text file. Now you
have to flag it as an
executable file. Right-
click on the icon for
the startup file you
created and choose
Properties. Now click
on the Permissions tab
and check the Is exe-
cutable box. The start-
up file should now be
ready to go. Restart
IceWM, and
Konqueror should
start automatically.
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Why do you start up kdesktop instead of
konqueror? Because kdesktop is the desktop
program that puts icons on the screen.
Konqueror is just the file manager/Web 
browser/coffee maker (it has a lot of features).
If you want only the file manager without the
desktop icons, then enter konqueror instead 
of kdestop This gives you basically the same
result as entering nautilus --no-desktop
instead of nautilus (see above).

DFM
Follow the same instructions above for either
Nautilus or Konqueror to create a startup file.
There is only one exception. When you get to the
part where you edit the contents of the startup
file, type dfm as the command instead of nautilus
--no-desktop or kdesktop. Restart IceWM in

order to launch the dfm file manager. See Figure 6
for an example of how your desktop may look.

AT THE END OF THE DAY...
IceWM is logically organized and a very capable
desktop. Most users will be comfortable with this
desktop, but some may be put off by a few flaws.
In its unmodified form, it is very bland to look at
and you will most certainly want to add a back-
drop of some sort. The menus presented are gen-
erally good, but there’s no auto-scrolling with real-
ly long menus, meaning the user will have to
resort to pressing the down arrow on the key-
board. Plus, the old and dictatoric window-man-
ager will become a nuisance for users who do a
lot with video applications. These flaws aside,
IceWM is still a very strong choice for most users;
it provides a lot of features without taking too
much of a CPU toll—highly recommended.�
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Figure 5. A Uniquely Configured IceWM Running
with kdesktop

Figure 6. IceWM Running DFM and a Program
(XMMS)

John Knight is a 21-year-old, rock-climb-
ing, Japan-loving megalomaniac, trying
to take over the world from his bed-
room via his keyboard. He spends most
of his time tinkering with MPlayer and
headbanging to his MP3s.

How Do I Run IceWM?
Choose it in your Session menu at startup.

Will it come with my distribution?
Maybe. It is usually included with Mandriva,
Libranet and SUSE. If it is not installed
automatically, it is almost always available
for your distribution. Just install it with
your favorite package manager (Synaptic,
Kpackage, YAST2 and so on).

TUX EXPLAINS
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DFM Home Page: http://www.kaisersite.de/dfm. 
DFM is available in the Debian archives or at
http://Freshrpms.net.

IceWM Home Page: http://www.icewm.org

IceWM Addons:
http://www.phrozensmoke.com/projects/
icewmcp/IcePref2/index.php

http://www.kaisersite.de/dfm
http://Freshrpms.net
http://www.icewm.org
http://www.phrozensmoke.com/projects/
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Last month, I reviewed Impress, a complete pres-
entation editing and publishing tool that is includ-
ed in the upcoming OpenOffice.org 2.0 suite.

I was actually quite impressed with Impress and
decided to take Calc for a spin this month. If you
are not familiar with Calc, it is the spreadsheet
application for OpenOffice.org. This review is of
the version of Calc that comes with the beta ver-
sion of OpenOffice.org 2.0. For a more thorough

explanation of how to use Calc (version 1.1.3 in
this case), see Kevin Brown’s article “How to Use
the OpenOffice.org Calc Spreadsheet, Part II” in
the August 2005 issue, page 23.

Calc allows you to manipulate data stored in a
grid through the use of formulas that can be
applied to the cells. Not only can you apply a for-
mula on an individual cell, you also can apply it on
an entire range of cells at once. This concept is

the same for basically
every spreadsheet
editor out there,
which makes these
applications ideal for
maintaining personal
budgets, quickly 
creating basic fore-
casting documents, 
or making calcula-
tions based on large
amounts of data in a
dynamic way, without
knowing anything
about programming.

On the Windows
platform, the Calc
counterpart is
Microsoft Excel;
although to be fair, a
lot of the power of
Excel comes from its

tight integration with VBA (Visual Basic for
Applications), which allows VBA programmers to
create some impressive tools in their spreadsheets.
This is beyond the scope of this article, and I
assume you are more interested in the more con-
ventional use of spreadsheets.

WHAT DOES CALC DO?
I’ve just explained that a spreadsheet editor lets
you enter values into grid cells and use expres-
sions and formulas to manipulate that data. You
may ask, “this sounds all good and great, but
what does it do that my calculator doesn’t?”

Meet Adam.
Adam is an accountant and loves playing with

numbers. He knows many formulas that can pro-
vide very useful infor-
mation from these num-
bers, and he has learned
to use Calc at work to
create interesting
reports showing his
managers where their
money is going.

Every year, Adam’s
company reviews the
performance of their
employees, and that
bonuses as well as raises
are given to employees.
Adam knows that the
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typical raise at his company is usually between
4% and 8%, and bonuses are based on profit,
and it has been a good year for the company.

Because Adam loves Calc, he created his own
spreadsheet to manage his budget, income and
expenses, but just like you or me, he is very excit-
ed at the idea of getting a raise.

He wants to plan how that raise will affect his
budget and his lifestyle, but he does not know the
exact amount of the raise or the bonus (if any).

CALC 101
For those of you who have used a spreadsheet
editor in the past, it should be obvious that a
spreadsheet like Calc is ideal for addressing
Adam’s concerns. Adam’s financial Calc spread-
sheet might look a little something like this:

� One table with the title Expenses has the head-
ers Item and Cost. All the rows in this table
describe expenses (Utilities→120,
Entertainment→240 and so on).

� One table titled Income has the headers Item
and Amount. The rows of that table break
down Adam’s income (salary, investments, inter-
ests and so on).

� The Variables table contains rows of key→value
pairs that are used throughout the spreadsheet
to avoid re-calculating too many elements (base
salary, money in wallet and so on).

� The Summary table is a report that contains sta-
tistics. He uses this table to figure out where his
money goes and to make his projections for the
next few weeks.

To perform calculations, a spreadsheet editor
needs to obtain values from cells. As a human
being, the most logical way to tell the program on
which cell it should operate is by providing it the
coordinates of the cell (for example, A2, C4, X17).
So in Adam’s financial sheet example, he entered
a few interesting formulas.

The Salary cell in the Income table, contains
the following:

=(B12*(1-(100*B13)/100))/12

Adam loves using big numbers with complex
ways to obtain simple results, and he loves to use
parentheses.

In Calc, a formula starts with the equal sign. By
pressing this key, you automatically enter the for-
mula editing mode. If you click on any cell while
you are entering a formula, Calc enters the coor-
dinates of that cell in the edit box. Additionally,
you can drag your mouse over multiple cells
(select a range of cells) and Calc will add the
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range of cells to
the formula.

Adam’s salary
formula deduces
the income tax
from his base
salary, and then
divides this
amount by 12 to
get a monthly

amount. His base salary is located in column B12
(Variables table), and the income tax rate is locat-
ed in B13.

Similarly, he entered the following formula in
cell E5: =(B15*B16)/12, which calculates the total
interest (B16) for his investments (B15), and
divides it by 12 to obtain a monthly amount.

FUNCTIONS AND RANGES
Adam may be fond of numbers, formulas and sta-
tistics, but he does not want to spend any more
time working out his budget than he absolutely
has to. He has entered all these figures in his
spreadsheets, and he does not feel like typing an
unnecessarily long formula such as this one to
obtain his total expenses: =B4+B5+B6+B7+B8.

Adam decides to use a function to do this for
him. In Calc, functions are pieces of functionality
that typically operate on a set of cells. Some func-
tions can take in several parameters, and others
have a limited set of parameters. To add numbers
together, Adam uses the SUM function. He opens
up the Total cell, types the equal sign (=) to enter
the formula editor and types SUM(. He then clicks
on the cell B4, and drags his mouse all the way to
cell B8.

When Adam presses the Enter key, he sees the
formula text box filled up with this: =SUM(B4:B8),

and the actual value displayed on the spreadsheet
for this cell is $1,155.00.

You can learn more about all the functions
provided by Calc by clicking on the Insert naviga-
tion entry and then clicking on the Function List
item. This brings up a panel on the left of the
screen that you can use to find functions and read
their documentation.

PATTERNS
Patterns are logical concepts that we apply in our
day-to-day life and usually don’t even notice.

If I give you the following sequence of num-
bers: 1, 2, 3, 4, 5, and ask you what the next
number of this sequence will be, you will instinc-
tively answer 6. The thought process is very quick,
and 6 seems like the logical choice.

What you really did by answering 6 to the pre-
vious question was look at the sequence and
establish a pattern that associated each number
with its prior. 2 is 1+1, 3 is 2+1, 4 is 3+1, and so
it is only logical to conclude that the last element
would be one plus its prior.

Computers have a very hard time dealing with
patterns, especially when it comes to identifying
them. This is precisely why Calc lets the user point
out patterns. Let’s see how this feature works.

Adam wants to add a variables to his spread-
sheet to change his base salary based on a raise
amount. He decides to add a new table to indi-
cate possible raise percentages (4–8%). He creates
the table and immediately adds values in two of
the cells. These values are 4 and 5. Adam then

selects the two cells and clicks on the
bottom-right corner of the cell con-
taining the number 5. He then drags
his mouse over the next three cells
and releases his mouse button. Calc

identified a pattern and added the values 6, 7 and
8 in the cells that were moused over.

All Adam needs now is to find out what his
base salary will be for each of the possible raise
amounts he might be getting this year. The
spreadsheet knows each of the possible raise
amounts (4–8%) and Adam’s base salary.

In the Raise Amounts table, the first column
(which we just created) contains the raise amount.
Adam types = in the cell beside the 4% cell, and
types in the following formula (assuming that the
4% amount is in the cell G3):
=B12*(1+((100*G3)/100)).

He can then enter the same formula in the next
cell, this time replacing G3 by G4. Technically, he
should now be able to select both new cells and drag
his mouse all the way to the cell beside the 8%
value, Calc should apply the same formula where B12
remains constant (because it is constant between
both cells), and G* is incremented each time.

Unfortunately for Adam, Calc did not notice
that B12 should remain constant between each
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cell. Because Adam can manually edit the formu-
las for each of these cells, he simply can replace
the erroneous coordinates with B12.

CHARTS
You’ve seen the screenshot of Adam’s financial
spreadsheet. His spreadsheet featured a 3-D chart
that provided a breakdown of his expenses.

To create the expense break-down chart, Adam
simply clicked on the Insert menu navigation and
selected the Chart entry. A wizard called Autoformat
prompted him to specify a range (a table containing
the data the chart will illustrate—Expenses in Adam’s
case) as well as whether or not the first row of the
table should be used as legend or data. The second
step allows Adam to specify the type of 2-D or 3-D
chart to generate, as well as parameters to help him
configure what data should be represented and how.

By double-clicking on the generated chart,

Adam was able to change the default fonts as well
as the borders and even opacity of the chart frame.

INSTALLATION
Many modern Linux distributions ship
OpenOffice.org as part of their standard desktop
package. On these distributions, you should look
for an OpenOffice.org Calc entry, or preferably,
OpenOffice.org 2 Calc.

If OpenOffice.org or OpenOffice.org 2.0 is not
installed by default on your desktop, you might be
able to run a search for it in the package manager or
updater program that comes with your distribution.

If you still aren’t able to find or install
OpenOffice.org for whatever reason, you can
simply download an installer for it at
http://download.openoffice.org/680/index.html.
If you have any trouble with that URL, go to the
OpenOffice.org site (http://www.openoffice.org)

and follow the instructions for downloading the
2.0 beta version (sometimes referred to as 1.9x).

Once you have completed the download, you
should be able to open your file browser, point it
to your download directory, and click (or double-
click, depending on your configuration) on the file
to launch the installer.

If you are still out of luck at this point, don’t lose
hope! Open up a terminal and type cd, followed by
the full path of your download directory. You should
then type chmod a+x followed by the complete
name of the file that was just downloaded and
press Enter (this will grant execution permission). At
this point, type ./ followed by the name of that file
(case-sensitive) and press the Enter key.

This should cover most possible cases; however,
it is still possible that you might not be able to
install OpenOffice.org on your computer for a vari-
ety of reasons. You can obtain help by launching an
IRC chat client (such as X-Chat, Gaim or Kopete),
connect to the freenode.org server and ask for help
from more experienced users in channels, such as
#linux, for example.�
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Figure 7. The Autoformat Chart Wizard

Xavier Spriet is a software architect at
Netmon, Inc., in Windsor, Ontario. He is
an avid reader and enjoys biking and
traveling. You can reach Xavier at
xavier@wuug.org.

About CALC

• License: Sun Industry Standards Source License
(SISSL), GNU General Public License (GPL) and LGPL.

• Price: Free
• Web site: http://www.openoffice.org

http://download.openoffice.org/680/index.html
http://www.openoffice.org
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It doesn’t matter what operating system you work
with when you turn on the computer: when it
comes right down to it, everyone uses electricity.

For notebook users, power is a constant con-
cern, especially for long-haul travelers; you often
see travelers perched in uncomfortable seats
while waiting to catch their flight, not because
it’s the only seat left, but because it’s the only
seat with a power outlet nearby. It’s not only
notebook users though. With the proliferation of
gadgets of all types—including cell phones, PDAs
and MP3 players—power is often in short supply
for people on the go.

If you’re one of those gadget fans who’s always
casing the joint looking for power outlets, here are
a few handy-dandy gadgets to help keep you out
of trouble—and topped up with electrons.

ELECTROVAYA POWERPAD

http://www.electrovaya.com
$249 US and up

If you’ve ever tried to use a notebook on a cross-
country flight, you probably already know that the
battery tends to run dry less than halfway through
the trip. It’s even worse if you’re making an over-
seas jaunt, especially if you don’t luck out and
secure a seat with a power connector.

Well, now you don’t have to worry about
running out of juice mid-flight. Electrovaya’s

PowerPad lineup of external batteries is
designed to sit directly under your notebook
like a notebook coaster, providing up to 24
hours of additional runtime before needing to
be recharged.

How does it do it? The PowerPad piggy-
backs onto the power connector that comes
with your notebook; you plug the PowerPad in
to your notebook’s power jack, and then plug
your regular power adapter in to the back of
the PowerPad’s jack. The PowerPad charges up
whenever you’ve got the AC adapter plugged
in to the wall; when you yank out the AC
adapter and hit the road, the power flows back
out of the PowerPad and into the notebook. To
the notebook, it still looks like it’s plugged in
to external power, until the PowerPad runs out,
at which point your notebook will use up the
two or three hours left in its own battery.

The biggest problem with the PowerPad is
that it’s not exactly lightweight, either in the
backpack or the wallet size: the $799
PowerPad 300 (which offers
up to 24 hours of
runtime) checks in
at more than six
and a half
pounds—about the
same weight as the
notebook itself. But to put
that into perspective, you’d
have to buy (and juggle) six to

eight regular notebook batteries at $150–200
apiece to achieve what the PowerPad 300
manages in one single battery. Another way of
keeping it in perspective is to note that you
can potentially run your notebook for three
eight-hour work days, with nary a power outlet
in sight, while you’re plugged in to the
PowerPad 300. How’s that for power?

If you’re looking for something a little leaner,
the PowerPad 120 and 160 weigh and cost less,
and consequently offer less runtime. But even the
PowerPad 80, which has a smaller form factor
better suited for use with subnotebook comput-
ers, offers enough extra power to keep you going
through that cross-country flight. In most cases,
you don’t have to go for the top-of-the-line model
if you want to stay powered up.

The PowerPad is compatible with most of the
models available from the major brands, as well as
some of the smaller companies. You can check to

see if your notebook is supported by
going to the Electrovaya Web site

and clicking on the
Compatibility List link.

Once you have
your PowerPad, you
also can use it with

other notebooks, so
long as you have the proper

power cord pack. When you buy the
PowerPad, you’ll get the power cords suited for

the model you specify, but you always can buy

GGaaddggeett  GGuuyy::  PPoowweerr  ttoo  tthhee  PPeeooppllee
SEAN CARRUTHERS
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additional connectors and swap between note-
books. (One at a time only, please.)

As with all battery technology, the PowerPad
requires a bit of maintenance. In other words,
you can’t just haul it out once a year for your
annual trip to Europe; you’ll have to charge and
discharge it every so often to make sure the
lithium polymer stays ready to use. If you’re
only a casual traveler, it may be a bit of a both-
er, but for those who know airports almost as
well as they know the supermarket, it won’t be
a problem at all.

SOCKET MOBILE POWER PACK

http://www.socketcom.com
$149

If you’re forever juggling eight different gadgets,
each of which requiring a power adapter, you
might want to check out the Mobile Power
Pack. It’s a Lithium Ion battery that’s slightly
larger than a deck of playing cards or an
audio cassette, with a jack on the bottom
for the included AC power adapter and a
USB port on the top for connecting up
your gadgets.

If you have any devices that get their
power directly from the USB port,
all you have do is plug them in to
the top and wait for them to
charge. The Mobile Power Pack
also comes with a number of
adapters, for items like the iPod,
recent Palm handhelds, Pocket PCs,
various cell phones and more. The
whole shebang comes in its own
travel pouch, so you can keep

everything together in one place when it’s not in
use. The battery even comes with a clip-on protec-
tive leather case so you can wear it on your belt
while it’s charging your gadgets.

The big downside for the Mobile Power Pack
is that you can recharge only one device at a
time, and if you’re constantly topping up your
gadgets, you’ll have to recharge it
regularly. But for the benefit of
getting rid of all of those other
power cords, it may well be
worth it.

VOLTAIC BACKPACK

http://www.voltaicsystems.com
$229

If you want to charge up
your gadgets, but spend
extended periods away

from power
outlets, it
may be
time to 
go solar.

The Voltaic Backpack would look like
a regular backpack if it weren’t for the

three large solar panels facing outward. It
comes with a number of pockets inside,
including one for your laptop, but it also fea-
tures a number of channels for your wiring, a
number of power adapters for your various
gadgets and a built-in battery pack for storing
the solar energy you collect while you’re out
and about.

It’s worth noting that, although there’s a
pocket inside the backpack for a notebook

computer, you can’t
actually use it to
charge your note-
book. It’s com-
patible with a
whole array of
portable gadgets,

though, includ-
ing a car
cigarette-
lighter-style
adapter, an
adapter with a
USB plug and 
connectors for various popular phones.
There are optional adapters available for

various other phones and PDAs, as well
as a mini-AA/AAA battery charger.

It’s also worth noting that the Voltaic
backpack is a bit heavy—three and a

half pounds—thanks to the inclusion of
the battery. It’ll feel especially heavy once

you load it up with your notebook and other
gadgets. Thankfully, the backpack is well-
padded and has adjustable straps to make sure
you can shoulder the additional weight.�
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Sean Carruthers is a freelance technology
journalist from Toronto. He spent six
years at Canada Computer Paper, first as
Products Editor at The Computer and
later at HUB Digital Living magazine. As a
freelancer, he has written for the Globe
and Mail, http://globetechnology.com,
HUB Digital Living, Computer Dealer

News, Homefront and CE-Biz. Although a relative newbie with
Linux (SUSE, thank you very much), he has extensive experience
with tech gadgets of all sorts and is enjoying figuring out which
ones are compatible with Linux.
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